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Papua New Guinea and its people 
To establish, preserve and improve standards of education throughout Papua New 
Guinea 
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It is our vision that Papua New Guineans’ harness all appropriate and affordable 
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COURSE INTRODUCTION 
 

 
 
Dear Student, 
 
Welcome to the FODE Grade 10 Design and Technology-
Computing Course. The Course consists of four units: 
 
UNIT 1: COMPUTER BASICS 

  UNIT 2:  WORD PROCESSING 2 
 UNIT 3: SPREADSHEET 2 
            UNIT 4: DATABASE 1 
 
Each unit is divided into 4 Topics which include all of the information you will need for 
this Course. You must have a functional computer with Microsoft Windows 
Application programs to fully apply all knowledge, skills and attributes necessary to 
gain full understanding and efficient transfer of learning for this course. A printer is 
needed for some assignments require printouts. 
 
Studying Design and Technology-Computing lays the basic foundation of necessary 
knowledge and aptitudes to contribute to future careers as technicians, 
programmers, analysts, administrators, managers and developer’s in the Information 
Communication Technology world. 
 
Assessments 
 

 Practice Exercises  
 Each lesson in each Unit Book has a Practice Exercise for you to do after the 

Summary. Answers to the Practice Exercises are found at the end of each 
Topic in the unit.  

 
 Assignments       

 Each Unit has an Assignment booklet which you will send to FODE Provincial 
Center for marking. The marked Assignment will be returned to you with 
comments and advice from your tutor. A mark will be given. This mark is 
counted towards your final mark in the exam. 

 
 Examinations      

The FODE national exams are given at the end of the year just like the exams 
given at secondary schools. 

  
For more information refer to the Study Guide. 
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Topic 1: Review of Word Processing Skills 
Topic 2: Formatting and Printing 
Topic 3: Tables and List 
Topic 4: Drawing, Charts and Pictures 

 

UNIT INTRODUCTION 
 

Unit 2 will introduce you to word processing where you will learn to use Microsoft 
Word application. The Unit consists of the following four Topics: 
 
 
 
 
 
 
 
 
By the end of this Unit you will have gained the skills and proficiency in the use of the 
word processing programs, able to demonstrate skills required for word processing. 
You should also be able to use design process to produce solutions involving word 
processing and able to demonstrate ethical values on computer use like sharing files 
on one computer. 
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CHECK YOUR ANSWERS AT THE END OF TOPIC 1. 

STUDY GUIDE 
 
 
Below are the steps to guide you in your course study.  

Step 1: Read each lesson in the Unit Book carefully. In most cases, reading 
through a lesson once is not enough. It helps to read something 
over several times until you understand it. You are not expected to 
memorise the information in the Unit Book. You should use it as a 
reference and to learn from the examples given to illustrate 
important points.  

Step 2: After reading the summary of the lesson, start doing the Practice 
Exercise. You must do only one practice exercise at a time. Then 
mark it according to the following instruction. 

 
 
Step 3: After marking your answers, go back to the lesson and correct any 

mistakes you may have made. Then move on to the next lesson.  

Step 4: After completing all the Practice Exercises, do Assignment 1. 

Step 5: Now send the completed Assignment booklet to your FODE 
Provincial Centre for marking.  

Follow all these steps 1 - 5 when completing all Unit Books.   
Be honest with yourself when you are doing and marking your Practice Exercises as 
well as completing your Assignment Booklets. 

This Unit has a separate assignment booklet for you to use. The information at the end of 
the last lesson in every Topic will let you know what to do with the assignment exercises. 

Whenever you need help and advice, contact your tutor or your Provincial Coordinator 
for assistance. If you are in the NCD or Central Province, we are available on Mondays 
to Fridays. You can call in anytime between 8 a.m. and 4 p.m. We would be glad to help 
you. 
The following icons are used in each Lesson in this Unit. Icons are the symbols used in 
this book to indicate the parts of your lessons. The following icons and their meanings. 

 
Whenever you need help and advice, contact your tutor in the Information Technology 
Department at FODE. 

We hope you enjoy learning this course. All the best! 

 
 
Information Technology Department 
FODE 
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TOPIC 1 
 
 
 
 
 

REVIEW OF WORD PROCESSING SKILLS 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson 1: Creating a Document 

Lesson 2: Changing Font Style and Size 

Lesson 3: Cutting, Copying, Pasting and Deleting Text  

Lesson 4: Changing Case and Justifying Text 

Lesson 5: Using Built-In Templates 

Lesson 6: Creating Templates 
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TOPIC 1: REVIEW OF WORD PROCESSING SKILLS 
 

In this topic you will learn about the basic concepts of documents. The Topic is 
designed to strengthen your knowledge and skills with word processing. It aims for 
you to gain basic understanding of facts and concepts necessary to have a head 
start in the study of computing. 

There are six lessons in this topic: 

Lesson 1  discusses how to create a document.  

Lesson 2  focuses on font, font style, font sizes and the steps on changing font, 
font styles and sizes. 

Lesson 3 explains the process of cutting, copying, pasting and deleting text. 

Lesson 4  discusses on how to change case and alignment. 

Lesson 5  emphasises on the definition of a template and the use built-in 
templates in creating documents. 

Lesson 6  explains how to create and identify the different uses of templates. 

By the end of Topic 1, you should be able to confidently open and use Microsoft 
Word program, create and save a document, save a copy of your document in 
another directory or location. You should be able to use print preview before printing 
your work, use the built-in templates and create your own template in Microsoft 
Word.  
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Lesson 1: Creating a Document 

 

 

 

 

 

 

You have learned in Grade 9 the basics of word processing. A word processor is a 
computer or computer program that is used to create, edit, and print documents. A 
word processor allows you to create a document, store it electronically, view it on a 
computer screen, modify it and print it. 

Starting MS Word 
There are many ways of starting MS Word. You have learned this in Unit 2 Lesson 1 
of Grade 9 Design and Technology – Computing. You may start MS Word by using 
any of the following ways: 
1. Clicking the MS Word icon from the desktop. 

2. Using the Start button and using the Start Menu to open the program. 

3. Opening the program from the Microsoft Office folder. 

Opening MS Word Program 
Sometimes MS Word program may not be available on the desktop. You can refer to 
your Grade 9 lesson on the different ways of opening MS Word. Let us open our 
program from the Start button. 

1. Click Start. 

2. Choose All Programs. 

3. Scroll to locate Microsoft 
Office folder. 

4. Click Microsoft Word 2010. 

 

 

 

 

 

 

Welcome to Lesson 1 of Unit 2. In this lesson you will revise on 
skills you have previously learned in Grade 9 Design and 
Technology – Computing. This lesson is about creating, and 
saving documents in different location or directories. 
  

1 

3 

4 

2 

Your Aims: 

 create various documents 

 apply word processing skills 
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Document 
Microsoft Word is a computer program that is used to create and edit documents. Let 
us revise on creating and saving a document.  

1. Open MS Word program. 

2. Type the following text. Do not worry about pressing the Enter key at the end 
of the line. When you reach the end of the line, the remaining text will 
automatically continue on a new line. Do not worry about the spelling mistake 
in your document. You can check and correct spelling mistakes later. 

 

 

 

 

 

 

 

 

 

 

 

 

Saving Your Document 
When you are working in MS Word, notice how your computer automatically saves 
your document using the AutoSave feature. This creates a temporary copy of your 
document in case of power failure. But you still need to save your document. Perform 
the following steps to save your document. 

1. Click File  Save As, the Save As dialogue box appears. 

2. The dialogue box displays the Documents Library.  

3. Since this is the first time you are saving a word document, the computer will 
ask you for a file name and file location. 

4. Use the suggested file name given by the computer.  

5. Click Save and close the document. 
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1. In your own words, list various ways of opening a MS Word Document.  

2. List the steps used to save a document. 

You have successfully completed this activity. You can also refer to previous Lesson 
in Grade 9 to revise on different ways of opening and saving your document. You 
may go at the end of this lesson to check your work. 

 

Opening Document 
There are many ways of retrieving/opening a saved document. Try to open your 
saved document from the Documents Library. Use any of the steps below.  

1. Click the Start button  Documents  double-click the file from the 
Documents Library. 

2. Open Microsoft Word program  File  Open  Click the document  
choose Open. 

 

Activity 1:  Opening and Saving Document 

The Save As dialogue box 



GR10 D&T – COMPUTING U2 13 TOPIC 1 LESSON 1 
 
 

 

 

 

 

 

 

 

 

 

Creating Folders 
You have just saved your document inside Documents Library. However, as you start 
saving your work you will notice that your saved work are all mixed together and 
disorganized. You can create folders to organize your work. Creating folders makes it 
easier to locate and store documents for easy filling. Choose from the different ways 
you can create a folder. 

A. Creating folders using the Open dialogue box.  
1. Make sure that the document “How well do you know others” is open. 

2. Click File  Open. The Open dialogue box appears.  

3. Click the New folder option. The New folder icon appears. Erase the 
word New folder and type Practice Folder 1. 

 

 

 

 

 

 

 

4. Click Cancel to close the dialogue box. 

B. Creating folder using the Save as dialogue box 
1. Make sure that the document “How well do you know others” is open. 

2. Click File  Save As. the Save As dialogue box appears. 

Click to 
create 
new 
folder 

The Open dialogue box 
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3. Click the New folder option. The New folder icon appears. Erase the 
word New folder and type Practice Folder 2. 

 

 

 

 

 

\ 

 

4. Observe that at the bottom of the screen you will find the Open icon 
where the Save icon should have been. This is because your folder is still 
selected or highlighted. Click anywhere in the Documents Library area 
and observe how it will change to Save icon. 

 

 

 

 

 

 

5. Click Practice Folder 2 and click Open. 

6. Make sure that the name of the folder appears in the window. 

 

 

 

 

 

 

7. The name of the document should appear in the Filename window. 

 

 

Change the name 
of the folder 

Open 
icon is 
displayed 
instead of 
the Save 
icon. 

The name 
of the 
opened 
folder also 
appears 
here. 
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8. Click Save. A copy of your document is saved in the Practice Folder 2. 

 

 

 

 

1. Create a folder called Drafts. 

2. Open a blank document and type any text in your document. 

3. Save your work inside Drafts folder. Use the Filename Saving Practice. 

You have successfully completed this activity. You have successfully created and 
saved your document inside your folders. Continue practising your saving skills using 
the folders. You could try to create another folder inside a folder. You may go at the 
end of this lesson to check your work. 

 

Summary 
You have come to the end of Lesson 1. In this lesson you have 
learned to revised on your skills in opening and saving of document 
which you have previously learned in Grade 9. This lesson you also 
learned how to create folders and save your document inside 
folders which is useful when organizing your files in the computer. 

 

 

 

 

  

 

 

 

 

NOW DO PRACTICE EXERCISE 1 ON THE NEXT PAGE. 

Activity 2:  Save Your Work Inside Folders. 
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Practice Exercise  1 

 

A. Create folder and Save documents. 
1. Type the following text.  

 

 

 

 

 

 

 

 

 

 

 

2. Before saving, create a folder called Malaria Files in the Documents 
Library. 

3. Save your document inside Malaria files folder. Use the filename Cause 
of Malaria. 

 

B. In a new blank document, type the following text: 

 

 

 

 

 

 

 

 

 

What causes malaria? 
Malaria is caused by protrozoan parasites of the genus 

Plasmodium – single-celled organisms that cannot survive outside of 
their hosts(s). 

Plasmodium falciparum is responsible for the majority of 
malaria deaths globally and is the most prevalent species in sub-
Saharan Africa. The remaining species are not typically as life 
threatening as P. falciparum. 
 Plasmodium vivax, is the second most significant species and 
is prevalent in Southeast Asia and Latin America. P. vivax and 
Plalsmodium ovale have the added comolication of a dormant liver 
stage, which can be reactivated in the absence of a mosquito bite, 
leading to clinical symptoms.  
 P. ovale and Plasmodium malariae represent only a small 
percentage of infections. A fifth species Plasmodium knowlesi – a 
species that infects primtes – has led to human malaria, but the 
exact mode of transmission remains unclear. 
 

Source: http//www.mmv.org/malaria-medicines/fivespecies 

800 die in malaria in PNG annually 
 As many as 800 people are dying of malaria each year in Papua 
New Guinea.  
 Statistics released by Population Services International (PSI) show 
that there are around one million malaria cases reported annually in PNG. 
 The health organization also says 18 percent of all deaths at PNG 
hospitals are malaria-related. 
 PSI anti-malaria advocacy manager, Iraingo Moses, says 90 
percent of the population is at risk of malaria due to inconsistent use of 
long lasting insecticide nets. 
 She says malaria continues to thrive in PNG for a number of 
reasons including population mobility, environmental changes due to 
developments, general worsening of health services and breakdown of 
drug supplies in rural areas 
 
The National newspaper 
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1. Save your document inside the Malaria files folder.  

2. Use the filename Malaria Death Toll. 

 

 

 

 

Answers to Activity 1 

1. List various ways of opening a MS Word Document.  

 Double clicking Word icon located on your desktop. 

 Click the Word icon pinned to the taskbar. 

 Clicking the Word icon located in the Start menu. 

 Using the Start button. 

2. List the steps used to save a document. 

a. Click the File tab. 

b. Choose Save As. 

c. Locate the Documents Library, folder and/or drive where you will save 
your document. 

d. Type the filename. 

e. Click Save. 

 

Answers to Activity 2 

Perform the following steps to check if your work is properly saved. 
1. Click File  Documents 

2. Check if you have Drafts folder. 

3. Double-click Drafts folder. This will open the folder. 

4. Check if the Saving Practice document is saved is saved inside the folder. 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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Lesson 2: Changing Font Style and Size 
 

 

 

 

 

 

 

Font Style and Size 
You have learned that font is a design for a set of characters, font style is a typeface 
variation (normal, bold, italic, bold italic) and the font size is the size of text 
characters, measured in units called points (pts.). You have also learned to change 
font, size and style in your Lesson 7 and 13 of Unit 2 Grade 9 Design and 
Technology- Computing. This lesson will add more concepts and skills to previous 
lessons in Grade 9. 

Many users of word processing program spend too much time worrying about the 
appearance of their document. Knowledge of font style and size may ensure better 
and appropriate document appearance. The letters, numbers and symbols that make 
up your text are referred to as characters. There are many ways of learning how to 
change the appearance of your characters.  

Using Quick Styles 
There are other ways of changing font style and size. Microsoft Word offers Quick 
Styles to apply different styles that you could apply various formats to your text 
without going through the many text formats. Follow the steps below to apply Quick 
Styles to your text. 

1. Open the document, “How well do you know others”. 

2. Highlight the title of the paragraph. 

3. Locate the Style options located in the Home ribbon. 

4. Click the Styles drop down list. 

 

 

 

5. Choose Title from the options given. This will automatically change the 
appearance of your text. 

 

Welcome to Lesson 2 of Unit 2. In Lesson 1, you have learned 
how to create a document. In this lesson, you will learn how to 
change font style and size.  
 Your Aims: 

 define font and font styles 

 identify font styles and sizes 

 identify the steps in changing font styles and 
size 
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6. Highlight the first paragraph and choose List Paragraph from the Styles 
option. 

7. Your work should look like the example below. 

 

 

 

 

 

 

 

 

 

Changing Styles 
You can further change the appearance of your document by using Preset Styles 
available in Microsoft Office. Perform the following task to change Styles.  

1. Click the down arrow in the Change Styles option. A drop down menu will 
appear displaying all the options. 

2. Click Style Set. The sub-menu will appear displaying all the choices available. 

3. Go through the different styles available. Observe that the entire document 
changes its appearance as you scroll through the available styles. 

4. Choose Perspective. The document automatically changed its appearance. 
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5. Your work will look the example below when finished. 

 

 

 

 

 

 

 

 

 

 

 

Colours 
Changing font colours gives your document a different look. It adds life and makes 
your document standout. Below are the different ways you can change your text 
colour. 

1. Click the Change Style option. 

2. Choose Colors. A palette of colours will appear. 

3. Choose one of the colour schemes available. Observe how the title and the 
first paragraph changes colour depending on the built-in colour you have 
selected. 

2 

3 

4 
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Fonts 
Fonts mean selecting the typeface of your text. You can also change the font type in 
the Change Styles option. Follow the steps below to change the font type of your 
text. 

1. Click Change Styles. 

2. Choose Fonts. The font option appears. 

3. Scroll down to display the different fonts available. Choose Origin. 

 

 

 

 

 

 

 

4. The font of your text automatically applies to the entire document. 

 

 

 

 

 

 

 

The name of the built-in font style. 

The font that will be 
applied to the title.  

The font that will be applied 
to the rest of the document. 

1 

2 3 

1 

2 

3 
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Saving and Printing 
It is a good practice to use Save As to save your work for the first time and use Save 
to constantly save your work as you are working with your document. Print your work 
only when you are done and ready to print a hard copy of your document. Perform 
the following task to save and print your document. 

1. Click File  Save. This will save changes you did to your document. 

2. Click File  Save As. The Save As dialogue box appears. 

3. Open Practice Folder 2. 

4. Type How well do your know others 2 in the Filename box. 

5. Print your work. Refer to Lesson 6 of your Grade 9 Design and Technology – 
Computing. 

 

 

 

 

A. Format the document using the Font option. 

1. Open the How well do you know others document. This should be the 
unedited copy. 

2. Highlight the title and choose Heading 1 from Styles. 

3. Choose Franklin Gothic, 25 pts., and Bold from the fonts option. 

4. In the Style Set option, choose Formal. The entire paragraph changed 
font, however the Title did not change the font and size.  

5. Choose any of the colour schemes. Observe how it changed the colour 
scheme of the Title. 

6. Highlight all the paragraphs and change the font size to 12. 

7. Save your work in Practice Folder 1.  

8. Use the filename Sample 1. 

9. Print your work. 

Thank you for completing this activity. You have successfully used Styles to changed 
font, font size and style to your document.  

 

 

Activity 1:  Using font and styles in the same document. 
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Summary 

You have come to the end of Lesson 2. In this lesson, you have 
learned another way of presenting your document. Using built-in 
styles makes it easier and convenient to change your document 
style. Applying Styles to your documents allows you to present your 
work in another way. Here you are using the built-in options available 
as well as further modifying your work in the Fonts menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 2 ON THE NEXT PAGE. 
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Practice Exercise 2 

 

A. Follow the given instructions below on how to add styles to your 
document.  

1. Open the “How well do you know others” document. This should be the 
unedited document. 

2. If you accidentally saved the changes from our practice exercise, 
highlight the entire paragraph and click Clear Formatting.  

 

 

 

 

 

 

 

3. Using the skills you have previously learned, present the same document 
in a different way. 

4. Use the following formats to edit your document. 

 Styles to Title and/or subtitle 

 Style set  

 Colours 

 Fonts  

5. Use any or all of the options given.  

6. Save your work as “How well do you know others 3” inside Practice 
Folder 2. 

7. Print your work. 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
 

Clear Formatting icon 
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Answers to Activity 1 

To check your work: 
1. Click Start  Documents. The content of the Document Library appears. 

2. Double-click Practice Folder 2. 

 

 

 

 

 

 

3. Right click the Sample 1 document and choose click Open. 

 

 

 

 

 

 

 

 

4. Your document should look like the example below. 
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Lesson 3: Cutting, Copying, Pasting and Deleting Texts 
 

 

 

 

 

 

 

 

Cut, Copy, Paste and Delete Text 
The Copy, Cut and Paste method uses the clipboard or buffer. The Clipboard is a 
temporary storage tool in Windows that can be used to store, copy and cut one or 
more information and paste it within the same document or another document. It 
works by placing selected text or objects in the clipboard and then pasting it where 
you want it to go. 

Cut is a command that allows you to "cut out" a selection of text or other data and 
save it to the clipboard or buffer.  It is similar to the Copy command, but instead of 
just copying the data to the clipboard, it removes the selected data at the same time. 
For example, if you highlight a sentence in a word processing program and select 
"Cut," the sentence is removed from the document and is added to the clipboard. 
Therefore, selecting "Cut" is a simple way to both copy and delete a selection in a 
single step. Copying refers to duplicating a section of a document and placing it in a 
clipboard. Paste is a command that allows you to insert data from the clipboard into 
an application. 

It is often necessary to rearrange text in a document using the copy and cut 
techniques.  The two methods that can be used are “copy & paste” and “drag & 
drop”.  

The Drag and Drop is another way of cutting text or objects. It uses the mouse to 
drag text from one location and drop it in another location. 

Before we start, type the following text in a blank document. 

 

 

 

 

 

 

Welcome to Lesson 3 of Unit 2. In Lesson 2, you have learned 
how to use built-in styles to your document.  In this lesson you will 
learn how to fully utilize the Clipboard for pasting and use the 
various ways of pasting text and images. You will also learn to use 
Drag and Drop as another way of moving text. 

Your Aims: 
 define cutting, copying, pasting and deleting text 

 perform the steps on how to cut, copy, paste and 
delete text  

 cut, copy, paste and delete text 

Save now for your future goals 
 
Set up a separate account 
Alright, now that you know how much you need to save and how much you can 
save, set up a separate bank account to put your savings into. That way the 
money will not get mixed into your everyday transaction accounts and 
“accidentally” spent! 
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Next, have you heard the expression “out of sight, out of mind”? Ask your 
employer to direct debit your allocated savings amount straight into your 
purpose-built bank account every payday. That way the savings money is never 
in your spending account and eventually you will even forget that it is 
happening. 
 
Do a Budget 
For most of us, saving money will mean cutting costs so that it can happen. The 
most effective way to cut your costs is to do a written budget so that you can 
work out what exactly it is that you do spend your money on. Try our budget 
planner to get started. 
 
There are plenty of ways to cut your expenses, such as repaying personal debt, 
taking a cut lunch to work, cutting your bank fees, cooking instead of getting 
takeaway, shopping with cash instead of credit. Even spending a few hours 
reviewing your telephone, electricity, car insurance and home insurance and 
contents insurance contracts could net you some significant savings. 
 
Allocate a Cost 
Allocate a cost to your important goals. When you divide that cost by the 
number of months between now and when you want to achieve the goal, it will 
give you a rough estimate of how much you need to save each month to make 
it happen. 
 
For example, a K5,000 holiday in two years time would be a savings goal 
around K200 per month between now and then. A K15,000 house deposit in 
five years time would be a savings goal of K250 a month. Once you know how 
much you ideally want to save you can look at some strategies to make it 
happen 
 
Know your finances 
While you will most likely start off your savings in a cash account, there are also 
other investment options available. 
 
What investment is right for you will depend in part on how long the money will 
be invested for (your investment timeframe) and how personally comfortable 
you are with certain forms of investment (your risk profile). For investments 
other than cash (such as shares and property) you should seek professional 
advice. 
 

Get a Plan 
The first step is to decide what it is that you want to save for. Whether it is 
something specific such as a holiday or a car, or a more general goal such as 
having a cash buffer for “just in case”, knowing what it is that you want will give 
you the motivation to start putting money aside. 
 
Grab a piece of paper and a pen and write a list of your goals under the 
headings “Short Term” (1-3 years), “Medium Term” (4-10 years), and “Long 
Term” (10 plus years). Then prioritise which goals are the most important to 
you. You might want the lot, but you’ve got to prioritise! 
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1. Create a folder called Saving Practice.  

2. Save your work inside Saving Practice folder use the filename Saving Tips. 

Using the Cut and Paste 
You have learned various ways of cutting and pasting text. Use any way of cutting 
and pasting that you are comfortable with. Use Cut and Paste to perform the 
following task. 

1. Locate and highlight “Get a plan” paragraphs. 

 

 

 

 

 

 

2. Click Cut from the Home ribbon.  

 

 

 

 

 

 

3. Position the cursor after the sub title and click Paste. 

 
Using the Clipboard 
To continue cutting and pasting text this way will require constant use of the cut and 
paste command. There is an easier way of doing this using the same techniques but 
this time we will use the Clipboard to paste our text. Perform the task below to cut 
and paste text using the Clipboard. 

1. Click Clipboard from the Home ribbon. The Clipboard appears in your screen. 

2. The Clipboard appears. Observe that the first few words of the paragraph you 
previously copied are displayed. 

3. Click Clear All to remove the content of the clipboard. 
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4. Highlight the second paragraph “Allocate a Cost” and click Cut. The 
paragraph is temporarily placed in the clipboard. 

5. Continue cutting the other paragraph. Follow the arrangement of the 
paragraphs to cut the text. 

6. Observe that first paragraph is moved at the bottom of the clipboard every 
time a new text is cut. 

 

 

 

 

 

 

 

7. Position the cursor below the last paragraph that you copied. 

 

 

 

 

8. Click Paste All from the clipboard. All the paragraphs in the clipboard are now 
copied to your document. 

9. Click X to close the clipboard.  

10. Open the Clipboard again. The paragraphs are still inside and will not be 
cleared until you select Clear All or you close the Word program. 

11. Click Clear All. 

The paragraph 
you previously 
cut 

Click to clear 
the content 
of the 
clipboard 
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Drag and Drop 
One of the easiest ways to cut and paste is to use the Drag and Drop. Be sure that 
you are skilled in using the mouse before you use the Drag and Drop method. 
However, this method only works if you are moving text within the document. Use the 
steps below to perform Drag and Drop to your document. 

1. Highlight the text you want to move. 

2. Click, hold and drag the mouse. Observe how the mouse pointer changes 
shape.  

3. Move the mouse to where you want to move the text. 

4. Release the mouse. 

 

 

 

 

1. A mistake was made with the arrangement of the paragraphs. 

2. The last paragraph must be located after the first paragraph.   

3. Highlight the last paragraph. 

4. Move your mouse pointer to any part of the highlighted text. 

5. Click and hold the mouse. Do not release. Observe how the mouse pointer 
and the cursor changes shape. 

6. Drag the mouse up and release when you reached the end of the “Get a 
plan” paragraph.  

 

 

Activity 1:  Cutting and Pasting using the Drag and Drop. 
 

8 

9 

11 
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7. Move the inserted paragraph to the next line. 

8. Click File  Save to save changes to your work. 

Thank you for completing this activity. In this activity, you have learned a different 
way of cutting and pasting.  Although easy to do, this requires a good control of the 
mouse and must be used only within the document. 

 

Using the Paste Option 
Perhaps while using the Paste, you have noticed some Paste Options in the drop-
down list but were not discussed before. Let us learn the different ways we could use 
other paste command options.  

1. Make sure that the Saving Tips document is open. 

2. Format the entire document. A sample format is shown below. Your work 
might look different from the sample given. 
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3. Change the format of the last paragraph “Know your finances”. Make sure 

that it is different from the rest of the paragraphs. 

4. Highlight the last paragraph. 

 

 

 

 

5. Click Cut and position the cursor below the title. 

6. Click the arrow pointing down in the Paste option. It will display the different 
paste options that you can use. 

 

 

 

 

 

 

 

 

 

7. Using the mouse, click the first paste option The paragraph pasted 
looks exactly like the paragraph you just cut. 

 

 

 

 

 

8. Click the second paste option, the Merge formatting option  Your 
work may look different from the example below. The paragraph will adapt 
(merge) to the format of the paragraphs near the location where you are 
pasting it.  

Keep source 
formatting 

Merge 
formatting 

Keep text 
only 
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9. Click the third paste option Keep text only Your work may look 
different from the example below. This paste option is only used if you are 
copying text and objects together. Text will be pasted and the paragraph will 
adapt (merge) to the format of the paragraphs near the location where you are 
pasting it.  

 

 

 

 

 

 

 

 

 

  

 

 

 

Deleting Text 
Delete means to physically removing text or object from the document or folder. Let 
us revise on your skills and see if you can complete this activity. 

1. Highlight the other paragraphs that you do not want to keep. 

2. Press Delete from the keyboard. The highlighted text disappears. 
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3. Save your work inside Saving Practice folder. 

4. Use the filename Save for your future. 

 

Summary 

You have come to the end of Lesson 3. In this lesson, you have 
copied, cut, and delete text from the document. You have also used 
different paste options to paste text which you copied or cut.   

 
 

  

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 3 ON THE NEXT PAGE. 
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Practice Exercise 3 

 

1. Type the following text. Use the default font format used in MS Word. Do not 
worry about the spelling errors that will appear on your document. 

 

 

 

 

2. Arrange the text in sequence. Use the sequence below as guide to arrange 
the text. 

 

 

3. Repeat the words/sounds. Do not worry about the spelling mistakes. 

 

 

 

 

4. Move the text to the next line. 
Use the example at the right 
side as guide. 

5. Use the specification below to 
format the following text. 

Font  : Ravie 

Font Style : Italic 

 Font Size : 20 pts. 

6. Save your work as Wonderful 
Mr Brown. 

 

 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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Answers to Activity 1 
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Perform the following task to check your work. 

1. Click the Start button  Documents. The Documents Library appears. 
2. Double click a Saving Practice folder in the Documents Library. 

3. The Saving Tips document should be inside the folder. Double-click to open 
the document. 

4. Your work may look different from the example given on the previous page but 
the arrangement of the paragraphs should be the same.  
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Lesson 4: Changing Case and Justifying Text  
 

 

 

 

 

 

 

Changing Case and Justifying Text 
In Unit 2 Lesson 10 of Grade 9 Design and Technology – Computing, you have 
learned on how to change the case and align text in a paragraph. Building up this 
skill is necessary in creating effective Word documents. 

MS Word provides a quick tool for switching text between uppercase and lowercase 
letters. You can also format text so that the first letters of each line or each word 
becomes lowercase or uppercase as needed in your document. 

Justifying text is just one of the different types of alignment that you can use on your 
paragraph. Other types of alignment include align text left, center and align text 
right.  

Changing Case 
There are different ways of changing case.  

1. Sentence case – the first letter of each sentence will become a capital. 

2. Lowercase – all selected letters will be in lowercase. 

3. Uppercase – selected text will be all in uppercase. 

4. Capitalize each word – first letter of each word will be in uppercase. 

5. Toggle case – uppercase and lowercase letters of selected text will be 
reversed. 

Let us learn how to use these options. Perform the following task to apply Change 
Case to your document. 
1. Open Sounds document. You have previously saved this in Lesson 3 Practice 

Exercise. 

2. Highlight the word “Mr. Brown”. 

3. In the Home ribbon, click the Change Case icon. The sub-menu will appear. 

Welcome to Lesson 4 of Unit 2. In Lesson 3, you have learned 
how to cut, copy, paste and delete text. In this lesson you will 
learn how to change case and alignment of your paragraph. 

Your Aims: 
 differentiate between changing case to justifying 

text 

 change case  

 justify text 
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4. Choose UPPERCASE. This will make the word all in capital letters. 

5. Locate all the “Mr. Brown” words and change to uppercase. 

 

 

 

 

 

 

 

6. Highlight the first two word sounds 
and change case to Sentence case. 
Observe what happened to your text. 

 

7. Highlight the next two word sounds 
and change the case to lowercase. 
Observe what happened to you text. 

 

 

8. Highlight the next two word sounds 
and change the case to Capitalize 
Each Word. Observe what happened 
to your text. 

 

Text was 
changed to 
UPPERCASE 
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9. Highlight the next two word 

sounds and change the case 
to tOGGLE cASE. Observe 
what happened to you text. 

 

 

Justifying Text 
By default the Align text left is the setting for all paragraphs in MS Word. However 
there are instances where we need to use different types of alignment. Let us 
practice changing alignment using the dialogue box. 

1. Make sure that the Sounds document is still open. 

2. Highlight the first line of the document and click the Paragraph dialogue box 
icon located in the Home menu as shown below. 

 

 

 

 

 

3. Locate General in the Indents and Spacing tab.  

4. Click the alignment window. This will display all the different types of 
alignments.  

5. Choose Centered. 

 

 

 

 

6. Click OK. Words within the paragraph line are placed equally on the left and 
right side of the document area. 
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7. Highlight all the sound words.  

8. Follow steps 2 – 4 and choose Right. 

 

 

 

 

 

 

 

9. Observe how the text moved to the right side of the document. 

 

 

 

 

 

 

 

10. Highlight the last line of the document. Repeat steps 2 – 4 and choose 
Justified. 

 

 

 

 

 

11. The spaces between words were increased to move the paragraph from the 
beginning to the end of the document. 

12. Save your work as Case and Alignment. 

13. Print your work. 
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1. Open a new blank document. 

2. Click Center in the alignment option and type “Today’s Horoscope”. 

3. Press Enter. Your insertion point will move to the centre of the next line. 

4. Click Align Left and type:  
Aries (March 21 to April 19) This is a good day for discussions with family 
members. It’s a particularly good day to talk about finances that relate to real 
estate and the family. 

5. Press Enter and click Align Right. Type the following text: 
Taurus (April 20 to May 20) You are in a positive, sensible frame of mind 
today. Because of this, you feel more generous to others, especially children. 
Future vocation plans look promising. 

6. Press Enter and click Center alignment. Type the following text. 
Gemini (May 21 to June 20) Behind-the-scenes activities might boost your 
income today. Write down your moneymaking ideas. They could relate to your 
earnings, a family business or a real estate deal. 

7. Press Enter and click Justify alignment. Type the following text. 
Cancer (June 21 to July 22) The Moon is in your sign today, making lovely 
aspects to both the Sun and Saturn. This makes you feel positive, balanced 
and in control of your scene. Others appreciate your practical advice. 

8. Use the following format to change the document: 
Font:  Comic Sans   

Font type: Bold (all zodiac sign) 

Font size: 12 pts.  

9. Change the case of the paragraphs: 
Title & Zodiac Sign : Uppercase 

Paragraph 1  : Sentence Case 

Paragraph 2  : Lower case 

Paragraph 3  : Capitalize each word 

Paragraph 4  : Toggle case 

10. Save your work as Horoscope. 

11. Print your work. 

 

Activity 1:  Follow the instructions to change case and 
alignment of paragraph. 
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Thank you for completing this activity. In this activity you have changed the alignment 
of your paragraph and change the Case of text after you finished typing your 
document. 

 

Summary 

You have come to the end of Lesson 4. In this lesson you have 
revised on the skills you have learned in Grade 9l about Alignments 
and how the paragraphs are lined up in your document. You have 
also learned various ways to Change Case which helps you edit text 
without re-typing the words. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 4 ON THE NEXT PAGE. 
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Practice Exercise 4 

 

A. Follow the instructions below. 
1. Type the following text in a blank document. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Change the font, size and style of the paragraphs. Use your own style. 

3. Change the case. 

Title    : Uppercase 

Paragraph 1   : Capitalize each word 

Paragraph 2   : Toggle case 

4. Change the alignment. 

Title    : Left 

Paragraph 1   : Center 

Paragraph 2   : Right  

5. Save your work as “Nursery Rhymes”. 

6. Print your work. 
 

 

Title 

Paragraph 1 

Paragraph 2 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 1.  



GR10 D&T – COMPUTING U2 45 TOPIC 1 LESSON 4 
 
Answers to Activity 1 
Your work should look like the example below. 

 

Use the table below as guide when checking your work. 

 

 Alignment Font Case 

Title Centre Font:  
Comic Sans 
 
Font type:Bold 
(all zodiac sign 
title) 
 
Font size:  
12 pts.  
 

Title (Uppercase) 
 

Aries Right ARIES (Uppercase) 
Paragraph text (Sentence Case) 

Taurus Left TAURUS (Uppercase) 
Paragraph text (Lower Case) 

Gemini Centre GEMINI (Uppercase) 
Paragraph text (Capitalize Each 
Word) 

Cancer Justified CANCER (Uppercase) 
Paragraph text (Toggle Case) 
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Lesson 5: Using Built-in Templates  
 

 

 

 

 

 

Built-in Templates 
A template is a pattern pre-formatted in some ways. So far in our lessons, you have 
created a document by starting to type in a blank document in MS Word. You could 
also create documents using built-in templates. Built in templates are pre-styled 
documents that you can use as a pattern for creating your own document.  

Using templates makes your document look professionally made without the trouble 
of formatting and designing the look of your document. 

MS Office has a website called Office.com that provides templates for many types of 
document including resume or curriculum vitae, cover letters, business plans, and 
business cards are only some of the document templates you can use. 

Using Built-In Templates in Writing 
Templates are normally used when creating specific type of documents like resumes, 
certificates, and memo. This saves your time rather than creating a document from 
scratch. To use the built-in templates, follow the following steps: 

1. Click File Tab New. The Available Templates displays all the different 
types of templates available in your computer and Office.com. 

 

 

 

 

 

 

 

 

 

 

Welcome to Lesson 5 of Unit 2. In Lesson 4, you have learned 
how to change case and justify the text in a paragraph. In this 
lesson, you will learn to use templates to create documents.  

Your Aims: 
 define a template 

 use the built-in templates 
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2. Choose Sample Templates. This will display the available templates in your 

computer.  

3. Scroll down to display other templates available. 

 

 

 

 

 

 

 

 

 

 

 

 

4. Select Apothecary Resume.  

5. At the right side of your screen, choose Document and click Create. This will 
create a new document. 

6. Move through the document. The parts of the document that can be clicked 
mean you can change its content. 

7. The screen tip will give you an idea as to what type of information you must 
place inside. 

 

 

 

 

 

 

 

8. Fill up the Resume Template with your own information. 

Scroll down to display available templates. 

Screen tip displaying the type of 
information you can place inside. 
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1. Open Microsoft Word. 

2. Click Sample Template and choose a letter template from the options given. 

3. Compose a correspondence letter to a fictitious scholarship you want to apply 
to in Australia. 

4. Replace the text, content of the template as needed. 

5. Change the font, size, style and colour of text as needed.  

6. Change the alignment of text as you see fit. 

7. Save your letter using your own filename. 

8. Print your work. 

Thank you for completing this activity. In this activity you learned to create another 
type of document using a template. You have also learned to customize the template 
using the skills you have previously learned in Grade 9 and Grade 10 Design and 
Technology – Computing. 

 

Working with Objects  
The templates contain objects or text boxes which you can use to enter text. 
However, you do not need all the objects in the templates. Refer to your previous 
lessons Lesson 17 of Grade 9 Design and Technology – Computing, when working 
with Objects. Perform the steps below to manipulate objects. 

1. Make sure that your CV template is still open 

2. Click any unwanted objects. The handles should appear around your objects. 

 

 

 

3. Press Delete from the keyboard to delete object. 

4. If you made a mistake when deleting objects, click Undo to return 
the object that you previously deleted.  

5. Move your mouse pointer to the left margin side of your document. Your 
mouse pointer will change shape to an arrow pointing to the right. 

6. Click hold and drag the mouse down to select the objects. 

Click handles to 
select object 

Activity 1:  Creating Document Using Template 
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7. Insert a Picture file in your document.  

8. A sample Curriculum Vitae is presented on the next page. It contains 
additional information that were copied and pasted in your document. Your CV 
may have more or less the same number of information.  

9. Save your work. Use any filename you want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Make sure that CV document is still open. 

2. Click the picture frame located at the upper right side of your resume. 

3. Click the drop down list to display options. 

 

 

 

 

Activity 2:  Insert and Format Objects. 
 



GR10 D&T – COMPUTING U2 50 TOPIC 1 LESSON 5 
 
 

 

 

 

 

4. Click Name with picture. 

5. Position the cursor on the picture and right-click the mouse. 

6. Choose Change Picture. 

7. Locate the picture you want to use for resume. Your work may or may not look 
like the example below. 

 

 

 

 

 

 

 

8. Edit your photo. Perform the following changes to your picture. 

a. Crop your object approximately 2 x 2 inch. 

b. Add a border around your picture. 

c. Change the colour of your object to Grayscale. 

d. Change Wrap Text of your object. Choose an option that will show the text 
and the picture together. 

9. Move your object to a location that will best display your picture. 

10. Save changes to your work. 

11. Print a copy of your CV. 

Thank you for using this activity. In this activity you have created a document using a 
template. You have also make changes to your template by adding and formatting 
text as well as inserting object to your document. 

 

3 
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Summary 

You have come to the end of Lesson 5. In this lesson you have 
learned all about Templates and how to use these templates to 
create a document.  Although the templates available in the Sample 
Templates are limited, it is still a good source of format you can use 
for your document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 5 ON THE NEXT PAGE. 
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Practice Exercise 5 

 

A. Follow the instructions below on how to use templates. 
1. Click File tab  New. 

2. From the Available Templates, choose Sample Templates. Scroll down 
and choose Executive Newsletter template. 

3. Fill in the details of your newsletter using the text inside documents 
“Cause of Malaria” and “Malaria Death Toll” saved inside the Malaria 
Files folder. You have created these documents in Practice Exercise 1 
Lesson 1 of this Unit.  

4. Do not type the text in the template. Use copy and paste to make 
transferring the text easier. 

5. You can move, add or delete objects in your template.  

6. Use Themes to change the colours and fonts of your Template. This can 
be found in the Page Layout tab. 

7. Save your work as Malaria Newsletter document. 

 

 

 

Answers to Activity 1 
1. The sample letter below uses the Apothecary Merge Letter template. The 

texts were replaced and some text frames were removed. Your work may look 
different from the example below. 

 

 

 

 

 

 

 

 

 

 

CHECK YOUR ANSWERS AT THE END OF TOPIC 1.  
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2. The sender company name and address was replaced by the respondents 
address. 
 

 

 

 

3. The address block was edited.  

 

 

 

 

 

 

 

 

 

 

Answers to Activity 2 

1. The content of you CV looks the same except that it contains your photo.  

 

 

 

 The date was typed 

 One of the text frames was removed  

 The <<  >> symbol covering the Address Block was removed. This symbol 
is used for merging this document to a database of addresses. 

Template Modified Template 

 A paragraph was removed from the template. 

 The closing was typed. 

 One text frame was removed. 
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Lesson 6:      Creating Templates  
 

 

 

 

 

 

 

Templates and Their Uses 
Templates are documents that store information and content that you may use 
regularly. It saves you from having to type the same information repeatedly.  

There are various uses of templates which are all available in the Office.com. These 
templates can only be used if you have access to the internet. You can also create 
your own templates which you can use for other purposes.  

 
Creating Your Own Template Using Built-in Template 
A Sample template can be saved either as a document or as another template. In 
Lesson 5 you have learned to save a template as a document. In this section you will 
learn to create your own template by following the steps on the next page. 

Welcome to Lesson 6 of Unit 2. In Lesson 5, you have learned to 
open a template and use it. In this lesson, you will learn to create 
your own templates which you can use like the templates found in 
the Sample Templates. 
  

 Your Aims: 
 identify the uses of templates 

 create a template 

Different uses of templates 
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1. Open Microsoft Word and click File  New  Sample template. 

2. Choose Executive Letter from the templates available. 

3. Move the paragraphs down the document to leave a space for our letter head. 

4. On the space provided, type the following texts: 

 

 

 

5. Highlight the paragraph and choose Title from the Styles options. Your text 
immediately changed to the format you selected. 

 

 

 

 

6. Click File. 

7. Choose Save As. The save as dialogue box appears. 

8. Scroll up to locate the Templates and double click to the folder to open it. 

  

 

 

 

 

 

 

 

9. Click the Save as type window and choose Word Template (*.dotx). 

 

 

 

 

Scroll up to locate 
the Templates 
folder 



GR10 D&T – COMPUTING U2 56 TOPIC 1 LESSON 6 
 
10. Use the suggested name in the filename window.  

11. Click Save. Your Template is now saved as a template. 

 

 

 

 

1. Open blank document. 

2. Click File  New  My Template. 

 

 

 

 

 

3. Click Create. A dialogue box appears. 

4. Click The Stationery Company  Template  OK. 

 

 

 

 

 

 

 

 

 

5. Customize your template.  
 Change the font size of the address, email and telephone number of the 

company. 

 Apply colour and formats to your text. 

 Click Clip Art. Search for any object that is related to Stationery (paper, 
pencil, books etc.) or any objects available in your computer. 

Activity 1:  Creating Your Own Template 
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6. Format your Clip Art image. Use the skills you have learned in Lesson 17 

Grade 9 Design and Technology – Computing. 

7. Move your object to your letter head. Use the example below as guide. 

 

 

 

 

8. Click Save to save changes to your work. Changes to your documents are 
now saved. 

Thank you for completing this activity. In this activity, you have learned to modify a 
template you created using built-in templates. This allows you to personalize your 
template which you can use again to create documents using these templates. 

 

Differentiate Document from Template 
A document and a word template may look like the same at first glance. Let us learn 
how to distinguish a document from a template. Perform the steps below to learn 
more about Templates. 

1. Click Start  Documents. The Document Library will appear. 

2. Scroll up and down to locate your template. Look for a document that has an 
extension name of .docks and .dots. 

 

 

 

 

 

 

 

 

 

Saving Template as a Document 

After creating your template from a document, you can now use the same templates 
to create future documents. Let us open our newly created template and save it as a 
document.  

.docx is a document file 

.dotx is a template file 

Whenever you write your filename, the computer adds an extension name to 
indicate what type of format was used to save a document. The .dotx indicates 
that your document was saved as a template while .docx is a document file. 



GR10 D&T – COMPUTING U2 58 TOPIC 1 LESSON 6 
 
1. Open Microsoft Word document. 

2. Click File. 

3. Choose New. 

4. Click My Templates. The dialogue box appears. 

 

 

 

 

 

5. Select the Stationery Company template in the New dialogue box. 

6. Choose Document in the Create New option and click OK. 

 

 

 

 

 

 

 

7. The Stationery Company template is now available in your screen. 

8. Fill in the details suggested in the objects. 

9. Click File Save As. The Save As dialogue box appear. 

10. Clicks create New Folder and create Stationery Company folder in the 
documents library. 

11. Type Letter 1 in the Filename box. 

12. In the Save As type window, choose Word Document (*.docx). 
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13. Click Save. 

 

Summary 

You have come to the end of Lesson 6. In this lesson you have 
learned all about Templates and how to create your own template. 
The template you created has the same function as the templates 
available in the sample templates. 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 6 ON THE NEXT PAGE. 

12 
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Practice Exercise 6 
 

A. Creating a Template 
1. Open the Malaria Report document. This document was previously done 

in your Unit 2 Lesson 20 of Grade 9 Design and Technology – 
Computing. 

2. If you do not have a saved copy, type your document again in a new 
blank document. A copy of the document is given below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once bitten, twice shy 
 

The importance of preventing malaria in PNG 
 
In tropical environments like Papua New Guinea, diseases carried by 
mosquitoes are rife and for foreigners with little to no immunity, just one bite can 
turn into a life-threatening illness. 
 
We have responded to a number of fatalities and life threatening medical 
evacuations of foreign workers due to malaria and other vector-borne diseases. 
Poor pre-travel advice, not taking anti-malarial medication, a lack of control 
programs on sites and inadequate diagnostic and treatment capabilities are 
contributing to these unwanted and avoidable events. 
 

The cost to companies of proper preparation for employees travelling to areas 
where malaria is endemic, compared to expensive medical evacuations, is 
minimal. Workers have as much responsibility in protecting themselves from 
being bitten by mosquitoes as companies do in reducing risk exposure and the 
company’s own liability. 
 
Malaria is more common in rural areas than in cities; this is in contrast to 
dengue fever, where urban areas present the greater risk. 
 
The planning for malaria control programs should begin during the feasibility 
stages of a project and be implemented during the site clearance and early 
mobilisation stages. The frequency of mosquito-borne diseases risk increases 
during a construction project because modification of the environment 
frequently changes the habitat in which the vector breeds. Under new 
favourable environmental conditions the populations of the mosquito vectors 
could increase in size very quickly. The influx of people into a construction area 
such as a new mine site may also play a role as it places an increased burden 
on limited services. 
 
If companies want to make a real difference to the incidence of vector-borne 
illness on their projects, compliance policies should be in place and enforced to 
ensure appropriate bite prevention behaviours are followed and preventive 
medicines are used appropriately. Despite best efforts in vector control, bites 
may still occur and so early diagnostic and treatment facilities must be available 
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3. If you typed your text, save your document as Malaria Text. 

4. If your text has formats, highlight the entire document and click Clear 
Formatting from the font options. 

5. Choose Executive Report as your sample 
template. 

6. Copy your text from Malaria document and 
use Merge formatting to paste the text 
inside the title, subtitle, abstract and side bar 
title. 

on site because timing is crucial to successful outcomes. Emergency malaria 
survival treatment kits may need to be available to employees where medical 
staff may not be present. 
 
Individuals need to be aware of how to protect themselves. While mosquitoes 
behave differently depending on where they are found, generic interventions 
such as covering up during bitting periods, using insecticide-treated bed nets 
and residual spraying of buildings can make a big difference to disease 
transmission. Expatriate staff should also understand which anti-malarial 
medication options are available and ensure they take prescribed medicines as 
instructed. 
 

Recognising the early symptoms and knowing how to seek treatment can be the 
difference between life and death for someone who has contracted malaria, 
dengue fever or another vector-borne illness. 
 
The early symptoms of malaria mimic illnesses and include headache, fever, 
muscular pain, chills and sweats.  
 
Other infectious diseases reduce worker productivity and need to be managed 
proactively through pre-employment screening, environmental management and 
early treatment programs. Amongst these is tuberculosis. Ensuring clean water 
and sanitation programs, proper pre-employment screening of employees and 
extended public health activities around the work site can mitigate many risks 
successfully. 
 
Our experience is that many cases of medical evacuation relate to pre-existing 
conditions of expatriate staff. Many of these can be identified during pre-
employment and pre-departure screening programs. Furthermore, proper 
preparation is a duty of care which is now an industry standard. 
 
About the author 
 
Dr. Dick Hooper is the regional medical director of medical services at 
International SOS, Australasia. He studied medicine at Cambridge University 
and has extensive experience in developing and managing complex health 
systems in multinational and multicultural environments across the 
governmental, NGO and oil sectors. 
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7. Use Destination theme when pasting 
the body of the document. 

 

 

8. Save your work as Malaria Report.dotx inside the templates folder.  

 

 

 

 

 

 

 

 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
 

Title 

Sub-
title 

Abstract 

Side Bar 

Body 
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Answers to Activity 1 

To check your work 
1. Open a blank document. 

2. Click File  Open. A dialogue box appears. 

3. Click Templates  The Stationery Company.dotx and click Open. 

 

 

 

 

 

 

 

 

 

4. The Stationery Company template is now open. This template must contain 
the letter head you created. 
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Answers to Practice Exercises in Topic 1 

 

Practice Exercise 1 

Rubric to assess your work 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. Malaria Files folder created in Documents Library.  
2. Cause of Malaria document and Malaria Death Toll 

document successfully saved inside Malaria Files folder. 
 

3. Cause of Malaria document and Malaria Death Toll document 
must contain the text shown in part A & B practice exercise in 
page 15. 

 

Perform the following task to check your work! 
1. Click Start  Documents. The contents of the Documents Library appears 

 

 

 

 

 

 

2. Double-click Malaria files folder. The content of the folder should appear. 

3. Inside your folder, two documents should be present. 
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Practice Exercise 2 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. Use of Quick Styles to title or any paragraph in the document.  
2. Use of Change Style - Style Set, Colors and/or Fonts to title 

or any paragraph in the document. 
 

3. The document How well do you know others 3 must be inside 
Practice Folder 2. 

 

Perform the following task to check your work! 
1. Open the document “How well do you know other 2” (this will be the sample 

lesson that you did in Lesson 2). 

2. Open the document “How well do you know other 3” (this will be the Practice 
Exercise 2 that you did in Lesson 2. 

3. Observe how you present the two documents.  

4. Take note of the similarities of how you made the two documents. 

5. Take note of the differences you made to make it different from the other 
document. 

6. Do not worry if your work may look different from the sample given below. 

 

 

 

 

 

 

 

 

 

 
How well do you know others 2 document 
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Practice Exercise 3 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. Wonderful Mr Brown must be saved in the Documents Library 

or any folder you created. 
 

2. Texts are arranged in sequence using Cut and Paste.  
3. Texts are repeated using Copy and Paste.  
4. Texts are moved to different paragraph line using Cut and 

Paste. 
 

5. Texts are formatted using the following specification: 
Font: Ravie; Font Style: Italic; Font Size: 20 pts. 

 

 

Your work should look like the example on the next page. 

How well do you know others 3 document 
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Practice Exercise 4 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. Nursery Rhymes document must be saved inside Documents 

Library or any folder you created. 
 

2. Title text must be all in Uppercase and Left aligned.  
3. Paragraph 1 must be aligned Center and all first letter of each 

word must be capitalize (Capitalize each word). 
 

4. Paragraph 2 must be aligned Right and all the first letter of 
each word must be small letter while the rest of the words are 
small letter (Toggle Case). 
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Your work should look like the example below. 

 

 

Practice Exercise 5 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. Malaria Newsletter document must be saved inside Documents 

Library or any folder you created. 
 

2. Executive Newsletter template was used.   
3. Texts were copied and pasted from “Cause of Malaria” and 

“Malaria Death Toll” documents. 
 

4. Themes (Colors and Fonts) were used to change the 
appearance of the template. 

 

5. Text boxes were changed and modified.  

To check your work 
1. Click File  Documents. 

2. In the Documents Library open Malaria Newsletter document. 
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3. Your work may look different from the example given on the next page. 

 

Practice Exercise 6 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 
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Task to perform 
1. Malaria Report.dotx must be saved inside the Templates 

folder 
 

2. Text inside the title, sub-title, abstract, side bar title and body of 
text must be copied and pasted from “Malaria Report” or 
“Malaria Text” document. 

 

3. Text pasted inside the title, sub-title, abstract and side bar will 
have the format set by the template when Merge Formatting is 
used. 

 

4. Text pasted inside the body of the template using Use 
Destination Theme will not adapt the format used inside the 
text box when texts are pasted inside. 

 

 

To check your work 
1. Open Microsoft Word program. 

2. Click File  New  My Templates. 

 

 

 

 

 

3. Click the Malaria Report.dotx 

4. In the Create New option, choose Template and click OK. 

 

 

 

 

 

 

 

 

5. Your work should look like the example on the next page. 
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End of Topic 1 

 

Now Do Exercise 1 in Assignment Book 1 Then Go to Topic 2. 
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TOPIC 2 

 

 

 

UNIT 2 

 

 
 

FORMATTING DOCUMENTS 
 

 

 

 

 

 

 

 

 

 

 

Lesson 7: Formatting Headers and Footers 

Lesson 8: Advanced Formats Using Format Menu 

Lesson 9: Using Word Art  

Lesson 10: Using Text Box 

Lesson 11: Using the Page Setup Dialogue Box 

Lesson 12: Using the Print Dialogue Box  
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TOPIC 2: FORMATTING AND PRINTING 

 

In this topic you will learn about the different ways of applying formats to your 
documents. The Topic is designed to familiarise you with changing appearance of 
text and applying styles to paragraphs. It also aims to guide you to fully utilize the 
printing of your document. 

This topic has seven (7) lessons: 

Lesson 7  focuses on applying and formatting the headers and footers of your 
document. 

Lesson 8  explains how to format your document using the advanced features. 

Lesson 9  discusses how to insert word art to your document and how it can 
change the appearance. 

Lesson 10 explains how to insert text boxes to paragraphs and parts of the 
document. 

Lesson 11  discusses how to use the page setup dialogue box to format the page 
setting of your document 

Lesson 12  explains how to print the whole document and/or selected parts of your 
document. 

By the end of Topic 2, you should be able to use word processing applications for 
specific tasks, design, produce and evaluate appropriate word processing solutions 
to a range of problems and use ethical practices when dealing with information and 
computer technology 
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Lesson 7: Formatting Headers and Footers 
 

 

 

 

 

 

 

 

Headers and Footers 
Headers and/or footers are usually used whenever you need to repeat text or 
graphics on a page. Usually this text are usually located at the top or bottom of the 
page. But header or footer is not confined to the top and bottom of the document, it 
can appear anywhere on the page (usually in the same place on every page). In Unit 
2 Lesson 12 of Grade 9 Design and Technology – Computing, you have learned to 
add header and footers to your document. 

Insert Header and Footer 
Let us learn to apply header and footer to our documents. This is the  Insert tab in the 
Office Ribbon showing the header and footer group. 

 

 

 

 

 

 

 

 

 

Follow the steps on how to insert header and footer: 
1. Open the Stationary Company document you previously created in Grade 10 

Lesson 6 of your Design and Technology – Computing.  
2. Open a New Blank Document and click Header in the Insert tab. Choose 

Blank from the option given. 

Welcome to Lesson 7 of Unit 2. In Lesson 6 you have learned to 
use templates to create your documents. In this lesson you shall 
learn how to format the headers and footers of your document.  

Your Aims: 
 identify the functions of headers and footers 

 identify the process on how to format headers 
and footers 

 determine the importance of using headers 
and footers 

Insert Tab 

This contains pre-formatted 
headers that can be used in 
the document. 

This contains pre-formatted page numbers 
that can be used in the document. 

This contains pre-formatted footers that 
can be used in the document. 
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3. Click the object and press Delete from the keyboard.  

 

 

 

 

 

 

  

4. Copy letter head you inside the Stationary Company document. 

5. Move to your New Blank Document and paste the copied text inside the 
Header area. Do not worry if your object covers your text. 

 

 

 

 

 

6. Highlight the entire text. The object will also be selected. 

 

 

 

 

 

 

Delete this object 

2 
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7. Click, hold and drag the tabular stop in the left indent tab until the text is no 

longer hidden behind the object. 

 

 

 

 

 

8. Click Close Header and Footer. 

 

 

 

 

 

9. Click Insert  Page Break to create your second page. Observe how the 
header you created is also placed in your second page and other succeeding 
pages. 

10. Click Insert  Footer and choose any style that allows you to type type the 
author of the document. 

11. Type your name in the author area and click Close Header and Footer. 

 

 

 

 

12. Observe your document contains the same header and footer in all the pages 
of your document. 

13. Save your work as Stationary Company 2. 

 

 

 

 

 

Drag the tabular stop to move text 

8 

 
Type name text inside text box. 
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1. Open Malaria Report document. This was the document you have previously 
done in Grade 9 Design and Technology – Computing. 

2. If you do not have this document in file, you can type or open any document 
you have saved as long as it has two or more page and follow the instructions 
stated in this activity.  

3. Click Insert . Header 

4. Choose Blank (Three Columns). 

 

 

 

 

5. Type the following text inside the Type Text area located in your header. 
Replace the information in your header if you use a different source. 

 

 

 

 

6. Click Insert  Page Number  Bottom of Page. 

7. Choose any format that you want from the options given. 

8. Save your work as Malaria Report Edited or use a different filename if you 
use a different document. 

Thank you for using this activity. In this activity, you have successfully added a 
header and footer to your document and changed the appearance of your document.   

 

No Header Or Footer On The First Page 
Most document does not contain a header or a footer at the tittle page or cover letter. 
Follow the steps below to remove the header and footer at the begining of your 
document. 

1. Open the document Malaria Report Edited.  

Activity 1:  Insert Header and Footer to a document 
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2. Double-click the mouse in any part of the Header area. The Header and 

Footer Tools will appear. 

3. Click Different First Page. Observe how the header will disappear from the 
first page of the document. 

 

 

 

 

 

 

4. Click Different First Page again to deselect the option. Observe how the 
header re-appears in your document. 

5. Click Different First Page again to remove the header and footer of the first 
page. 

6. Click Close Header and  Footer icon. 

7. Save changes to your work.  

 

Odd And Even Header And Footer 
Documents are normally printed back to back. To give life to your document, you can 
use a different header or footer on the odd (left) and even (right) pages. Perform the 
task below to apply header and footer to odd and even pages of your document. 

1. Make sure that the Malaria Report Edited document is open. 

2. Double-click any part of the Header.  

3. Click Page Number and choose Remove Page Number from the options 
available. 

 

 

 

 

 

 

 

Header and Footer tools 

3 
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4. Scroll down to move to the even page.  

5. Click Insert  Page Number  Bottom Page and choose Plain Number 1. 

 

 

 

 

 

 

6. The Even Page Footer will display page 2. 

 

 

 

7. Scroll down to move to the odd page. 

8. Click Insert  Page Number  Bottom Page and choose Plain Number 3.  

 

 

 

 

 

 

 

 

9. The Odd Page Footer will display page 3. Your work should look like the 
example on the next page. 

Click 

 

Choose from different Bottom 
Page styles. 
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10. Click Save to save changes to your work. 

 

Summary 

You have come to the end of Lesson 7. In this lesson you have 
inserted and removed header and footer of your document. You 
have also learned to change how the header and footer will appear 
in your document by using the different ways of inserting headers 
and footers 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 7 ON THE NEXT PAGE. 
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Practice Exercise  7 

 

A. Follow the instructions below. 
1. Write a three page document on the topic “Little Ways I Could Save the 

Environment.” You can also copy any article in the newspaper, 
magazine or any other publication. Just make sure that it will not be less 
than three pages. 

2. Use your own formatting styles to write your document.  

3. Your document should have the following: 

Page 1 : Cover page 

Page 2 & 3 Body of the document 

4. Apply Header and Footer to your document. Use the name of the essay, 
your name and page number in any part of the header or footer. 

5. No header and footer will be used for the cover page (first page) 

6. Use your own filename to save. Print your work. 

 

 

 

Answers to Activity 1 

1. Open the document Malaria Report Edited or the file you used for this 
activity.  

2. The image below shows the document Malaria Report Edited having the 
Header and Footer on all the three pages of the document.  

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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3. The example below shows the Header and Footer that your document should 

have. Your work will have a different header and footer content if you use your 
own document file. 

The header will be visible on all the pages of the document. The footer will 
contain the pages numbered 1-3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Header 

Footer 
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Lesson 8: Advanced Formats Using Format Menu 
 

 

 

 

 

 

 

In Lesson 13 of Unit 2 Grade 9 Design and Technology- Computing, you were 
introduced to changing font and font sizes. There are many character formatting 
options that are not available on the toolbar that are available in the Font formatting 
dialogue box. When you have selected text, you can open the Font dialogue box 
from the home ribbon as shown below. 

 

 

 

 

 

 

Before moving on, let us first type the following text. Do not forget to save your 
document using your own filename. 

 

 

 

 

 

 

 

 

 

Your Aims: 
 identify the location of the format menu 

 distinguish different formats found in the 
format menu 

 determine the importance of using format 
menu 

Click to display the Advanced 
Formats options. 

Day of Mourning 
Haus krai on May 15 to highlight violence and suffering of women. 
A NATIONAL day of mourning, a haus krai (house of mourning), will be held on 
May 15 to highlight the violence and suffering of women in Papua New Guinea 
through allegations of witchcraft, rape, and murder. 
It is being organized by American preacher, Stephen Michael Leach, in light of all 
the recent cases of violence against women in PNG. 
“The burning of a woman suspected of witchcraft in Hagen shocked us as a 
nation,” he told The National. 
“Internationally, it shocked the world that his could happen in 2013.” 
“We thought that was the worst, but over the last few weeks, we have watched as 
the situation has deteriorated.” 
“Violence has escalated at a phenomenal rate,” Leach added. 

Welcome to Lesson 8 of Unit 2. In Lesson 7, you have learned 
about formatting headers and footers. In this lesson, you will learn 
how to apply advanced formats using Format menu. 
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Apply formats to your document. Perform the following task to your document. Use 
the skills you have leaned from previous lesson to format the document. 

1. Use Spelling and Grammar to check for spelling errors in your document. 

2. Your work may look different from the example below. 

 

 

 

 

 

 

 

 

 

 

 

Aside from the usual formatting, the are various ways you can improve your 
document.  

Character Spacing 
Character spacing is one of the advanced features of font formats. It allows you to 
increase or decrease the width and spacing between each word of the sentence. 
Perform the following task to add change Character Spacing. 

1. Highlight the title of the document. 

2. Click the icon to show the Font 
dialogue box. 

3. Choose the Advanced tab. 

 

 

 

 

 

 

The Advanced tab 

Body of text 

Sub-Title 

Title 
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4. Click the down arrow in the Scale option and choose 200%. Notice that the 

text size increase. Observe how the text increases without but the font size 
window still displays the same font size you have previously used. 

 

 

 

 

 

 

 

5. You can also type directly inside the Scale dropdown list. Type 120%. 

6. In the Spacing option, choose Expanded and use 3 pt.  

 

 

 

 

 

 

7. Highlight the sub-title of the document. Adjust the scale to 80%, Condensed 
by 1pt and Raised by 20 pt.  

 

 

 

 

 

 

 

 

8. Save your work as Haus Krai. Your work should look like the example on the 
next page. 

 

Advance tab 

Click drop down 
list and choose 
200%. 

Click drop 
down list 
and choose 
Expanded. 

Click up or 
down to 
change 
spacing 
size. 

Use the setting given above to adjust the Scale, Spacing and 
Position of the sub-title. 
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Kerning 
Kerning is not an option commonly used but quite useful for adjusting the spacing 
between unevenly shaped letters in large font sizes. Perform the following task to 
apply Kerning to your text. 

1. Open a new blank document. 

2. Type the the following text “TIDAL WAVE WASHED THROUGH TOWN” 

3. Change the format of your text. Use the options given below: 

Font  : Times New Roman 

Font Size : 36 

4. Observe how the spacing between letters are placed in your document. 

  

 

 

 

 

 

5. Highlight the text and open Font dialogue box. 
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6. Select Advanced tab and tick Kerning. The points window automatically 

contains the actual size of the text. Observe how the spaces between the text 
changes in the preview options. 

 

 

 

 

 

 

 

7. Click Ok to apply changes to your text. 

8. Observe the following changes in your document. 

Before the use of Kerning 

 

 

 

 

 

 

After the use of Kerning 

 

 

 

 

 

 

9. Save your work as Kerning Practice. 

 

 

6 
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10.  

 

1. Type the following text taken from April 2014 PNG Report. Type it as it is set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Format the Title 1, Title 2 and Title 3. Change type, size and colour of text as 
needed. 

 

 

 

 

 

 

3. Use a font size bigger than 50 pts for Title 1 & 2. 

4. Apply advanced format to the Title 1 – 3. You can scale or adjust the spacing 
to have the same effect as the example above. 

Activity 1:      Apply Advanced Formats to Text 
 

FIRST 
GAS  
by Alison Middleton 
 
Exxo Mobil is looking at expansion opportunities for a third LNG train in 
Papua New Guinea, with first liquefied natural gas from the PNG LNG 
project expected to move on stream midyear. 
 
An analysts meeting in the US heard the projected pipeline was one of 10 
new projects that were expected to give ExxonMobil 300,000 net oil 
equivalent barrels per day of new capacity. 
 
The two-train, 6.9 million-tonnes-per-annum capacity PNG LNG project has 
been due to start production late this year, but is proceeding months ahead 
of schedule. 
 
ExxonMobil senior vice-president Mark Albers said the successful execution 
of the PNG LNG project had allowed the company to unlock potential of the 
high-quality 9 trillion cubic feet resource.  
  
“Despite many challenges, the project is actually progressing a few months 
ahead of schedule, the first cargo delivery in the middle of this year,” he 
said. 
 

Title 1 

Title 2 

Title 3 
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5. Change the font, size and style of the body of the article. 

6. Apply Kerning to the paragraphs. 

7. Save your work as ExxoMobil. 

Thank you for completing this activity. In this activity you have used advanced 
formats. By incorporating advanced formats to your text, you have completely 
changed the appearance of your document that the traditional font formats cannot 
accomplish. 

 

Summary 

You have come to the end of Lesson 8. In this lesson you have 
learned to apply advanced formats to your text using the Character 
spacing and Kerning for fonts. These special options make your text 
look different from the normal font styles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 8 ON THE NEXT PAGE. 
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Practice Exercise  8 

 

A. Type the following text and follow the instructions after the box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Format the document. Use the specifications below: 

Title:   Elephant, 36 pts. Center align 

Sub-title: Perpetua, 28 pts, Center align 

Michael Faraday 
This boy taught himself by reading science books! 
In England in the 1800s, there lived a boy. In those days children often went to 
work early after gaining a small amount of education. 
Such was the boy Michael, who was to work as a helper to a bookbinder. While 
there he read science books. In this way he learned many things by himself. 
One day, he heard that a famous scientist named Humphry Davy was to give a 
lecture in town. He got a place there, and while the scientist was talking, Faraday 
took notes down in his notebook. 
Later he compiled the notes with nice diagrams and sent them to Davy, and 
requesting for a job at the place that Davy was the boss of, the Royal Institution in 
London. 
Davy was impressed with the boy’s notes but said there was no job available. 
Years later when there was a place at the institution, Davy sent for Michael, and 
the boy started work there, at the age of 21, as a laboratory assistant. 
During his early days he worked with chemical problems and experiments and 
went on to study others – like electricity and magnetism. 
Michael Faraday became a famous scientist. Even though he was not highly 
educated, he was practical. 
He is known as one of the top scientists in experimenting (or experimentation) to 
come up with results. (Some scientists do not do as many experiments as others, 
they think up ideas more.) 
Some of the ideas that he came up with included the relationship between 
magnetism and electricity – or electromagnetism. 
Ideas in that field helped in the invention of electric motors which are present in all 
appliances that have moving parts e.g. fan, mixer, washing machine and vacuum 
cleaner. 
Michael’s ideas also helped in the use of electricity to separate chemicals, a field 
called electrolysis. 
When Davy was asked what his best discovery was, he said:  “My greatest 
discovery was Michael Faraday.” 
Young Life May 1, 2013 
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Paragraphs: Century School, 12 pts, Justified 

Indention: First line of all the paragraphs 

Reference: Century School, 12 pts, Bold, Italic, Right align 

2. Use advanced formatting to: 

A. make the Title stretch across the width of the document. 

B. make the Sub-title appear in one line paragraph line. 

C. make the entire document fit in one page. 

3. Save your work as Advanced Formats. 

4. Print your work. 

 

 

 

Answers to Activity 1 

1. Open ExxoMobil document. 

2. The following Advanced Formats were used in the document. 
Title 1: Nil 

Title 2: Scale (140%) 

Title 3: Spacing (4 pts) 

3. Kerning was used on all the three title. 

4. The following formats were done to the sample document. Your work may or 
may not look like the example given. 
Font :  Calibri 

Size : 72 pts. 

Style : Bold 

 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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Lesson 9: Using Word Art 
 

 

 

 

 

 

 

 

In Lesson 17 Grade 9 Design and Technology – Computing, you have learned about 
graphics. WordArt is an example of graphics which can be created within MS Word. 

WordArt is a set of graphic fonts that adds a touch of flair to your text. It allows you to 
create decorative text to be used for headings and to emphasize certain parts of the 
document. Once you have created WordArt, it is treated as an object within the 
document. 

WordArt uses a feature that allows it to work the same way as other programs do,  
such as Excel and Powerpoint.  

To Insert WordArt 
Use WordArt sparingly. It is most effective when you do not use this too much within 
the document. Perform the task to insert WordArt to your document. 

1. Create a new blank document. 

2. Click Insert tab from the ribbon and choose Word Art. 

 

 

 

3. The WordArt gallery appears.  

 

 

 

 

 

Your Aims: 
 define word art 

 identify location of the WordArt 

 identify the steps in using WordArt 

 determine the importance of using WordArt  

Welcome to Lesson 9 of Unit 2. In Lesson 8, you have learned 
about applying formats to your text. In this lesson, you will learn 
how to use Word Art.  
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4. Choose Black, Outline from the options given. A text box is inserted in the 

document.  

 

 

 

 

 

5. Observe how a new tab called Format is added on the ribbon containing 
drawing tools. This is only available if the objects are selected. 

 

 

 

 

 

6. Click outside the text box and the Format tab disappears. Click the object 
again. 

7. Type “Flexible Open and Distance Education” inside the box.  

8. Your WordArt contains handles that allows you to change the size and 
position of your object. You have learned all about objects in Lesson 17 Grade 
9 Design and Technology – Computing.  

 

 

 

 

 

 

 

 

Editing WordArt 
You can change the WordArt object after you made your choice. Before you edit, 
make sure that the text in the object is highlighted. Follow the following steps to edit 
WordArt. 

Click hold and rotate the 
handle to rotate the object. 

The handles 
at the sides 
of the 
objects 
resizes the 
objects 
horizontally 
and 
vertically. 

Position cursor at any part of the object 
border and click, hold & drag object to any 

part of the document  
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1. Locate the WordArt Styles. Click the down arrow to display more WordArt 

styles. Choose from the styles available to replace the visual styles of text. 

 

 

 

 

 

 

 

 

2. Choose any styles available. Your 
work may or may not look like the 
example below. 

 

 

3. The Text fill options allows your to 
change the colour of the style you 
choose. 

 

 

 

 

4. The Text Outline places colour at 
the outline of your text. It is a 
good practice to use a different 
and/or darker color for your text 
outline. 

 

 

 

Visual styles for text 

Click to display the 
styles available. 

Choose from the 
palette of colors 
available 

Choose from the 
palette of colours 
available 
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5. You have successfully learned how to apply Text fill and Text outline to your 

WordArt. This gives your object visual appeal and colour. Your work may or 
may not look like the example at the next page. 

 

 

 

 

 

 

 

 

 

 

 

 

1. Make sure that the ExxonMobil document is still open. 

2. Higlight Title 1 and 2. 

3. Choose any WordArt style. You can increase the size of the WordArt. Adjust 
the font size of the text if you do so. 

4. From the Text Effects apply the following changes. Use the screen tip to 
identify the name of the type of text effect  use. 

Shadow - Inner 

Reflection - Tight Reflection, Touching  

Glow  -  Olive Green, 18 pt. glow, Accent color 3 

Bevel  - Convex 

3-D Rotation - Off Axis 1 Right 

5. Click outside to apply changes to your object. 

Thank you for completing this activity. In this activity, you have learned how to insert 
WordArt to your document and applied Text Effects to it. This shows your object 
different ways giving it different look and dimension to it. These effects can be 
changed again depending on the design and style of the user. 

 

Activity 1:  Apply And Format Word Art 
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Summary 

You have come to the end of Lesson 9. In this lesson you have 
learned to inset another type of object called WordArt. WordArt adds 
appeal to your document but can only be used at least once within 
the document to maximize its effects. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 9 ON THE NEXT PAGE. 



GR10 D&T – COMPUTING U2 97 TOPIC 2 LESSON 9 
 
Practice Exercise  9 

 

A.  Follow the given instructions. 
1. Open Advanced Formats document. 

2. Use WordArt to change the Title and Sub-title of your document.  

3. Change the format of your WordArt styles. Make sure to use all or any of 
the following:  

A. Text Fill 

B. Text Outline 

C. Text Effects 

4. Save your work as Michael Faraday. 

5. Print your work. 

 

 

 

 

Answers to Activity 1 

Your work should look like the example below. Note that there are some features that 
cannot be seen from the printed example below but can bee seen in your computer. 

 

 

 

 

 

 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
 

The image displays the WordArt Styles and Text Effect applied to Title 1&2 
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Lesson 10: Using Text Box 
 

 

 

 

 

 

 

Text Box 
A text box is a user created box that contains an insertion point and typed text. Text 
box, like WordArt, is a type of objects which can be inserted to your document. You 
can resize, rotate, format text, add borders and shading, just like what you would like 
to do to any type of object. 

Follow the instructions below to insert text box: 

1. Open a new blank document. 

2. Click Insert tab and choose Text Box. The Built-In text boxes appear on your 
screen. 

 

 

 

 

3. Scroll down to display the different text boxes. Locate and click Alphabet 
Quote. 

  

 

 

 

 

 

 

 

Welcome to Lesson 10 of Unit 2. In Lesson 9, you have learned 
to insert and edit a type of object called WordArt. In this lesson 
you will learn to edit and manipulate another type of objects 
called Text Boxes. 

Your Aims: 
 define a text box 

 identify process of inserting and editing a text 
box  

Use the 
scroll button 
or scroll bar 
to display the 
different text 
box 
available. 



GR10 D&T – COMPUTING U2 99 TOPIC 2 LESSON 10 
 

A text box will be inserted in your document. 

 

 

 

 

 

 

 

 

 

 

4. Using the handles, resize and stretch the object. This means that you can 
make the text box fit any shape you want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Close the document without saving. 

 

Write your text inside the text box. 

While the text is still 
highlighted   press 
Delete to remove text 
inside the text box.  
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Draw A Text Box 
Sometimes the Built-in text boxes are not suitable for what you need. It is then easier 
to create your own text boxes. Follow the steps below to draw a text box. 

1.  Click Insert  Text Box and Draw Text Box. 

 

 

 

 

 

 

 

 

 

2. Click, hold and drag the mouse when your  mouse pointer turns into a cross.  

 

 

 

 

 

 

3. The text box will be inserted. Release the mouse when the desired size of the 
text boxes is achieved. 

 

 

 

 

 

 

 

4. Type “FLEXIBLE, OPEN AND DISTANCE EDUCATION” inside the text box. 

Click, hold and drag the 
mouse pointer. 

Cursor automatically placed inside the text box. 

Click to 
choose from 
built-in styles. 

Click to 
create your 

own text box. 
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Text Box Alignment 
You have learned to change alignment of text in the previous lesson. The skills you 
have learned  on alignment can also be applied to your text box. Follow the steps to 
align text in your text box: 

1. Make sure that the text inside the text box is still highlighted. 

2. Choose from the different Text Direction available. 

 

 

 

 

 

 

 

3. Choose from the different Text Alignment available. 

 

 

 

 

 

 

 

4. Return the text box to its original alignment. 

 

Format Text Box 
You have learned to format text in the previous lesson. The skills you have learned  
on alignment can also be applied to your text box.  

1. Make sure text inside the text box is highlighted. 

2. Use the WordArt Styles to format the text in your text box. 
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3. Below is an example of what your text box can look like. Your work may look 
different from the example below. 

 

 

 

 

 

 

 

 

4. Click inside the text box to edit the WordArt Styles you selected. While editing, 
you might notice that the Text Effects changes to another style. Do not worry. 
This will return once you click outside the text box. 

 

 

 

 

 

 

 

5. Resize the object by clicking, holding and dragging the handles in the text box. 
The object will automatically resize and change its shape. 

6. Save your work as Fode Text Box. 

 

 

Click drop-
down list to 
choose 
from 
different 
WordArt 
Styles. 
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Changing Outlines of Objects 
An object is surrounded by a line or outline to identify that the object is selected and 
ready for formatting. This outlines are presented as broken lines in WordArt objects 
and solid line in a Text Box. 

Follow the instructions below to change the outlines of your object. 
1. Double-click the object and to display Drawing Tool tab in the ribbon. 

2. In the Shape Outline option, choose from the colors available to change the 
colors of the outlines.  

 

 

 

 

 

 

 

 

3. Click Weight to change the thickness of the outline of your object. 

 

 

 

 

 

 

 

4. Choose from different style of your outline from Dashes options. 
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5. If your object does not need an outline, you may remove the outline by clicking  
No Outline. 

 

 

 

 

 

 

 

 

Shape Fill 
The text box you created can be filled with colours to 
emphasize the text written inside. Peform the following 
steps to apply Shape Fill to your text box. 

1. Make sure that your text box is selected. 

2. Click Shape Fill. A pallette of colours will 
appear. 

3. Choose a colour from the pallette. 

4. Click No Fill to remove fill.  

  

 

 

 

 

Click and 
choose from 
the different 
line styles. 

2 

3 

4 
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1. Open document ExxonMobil Edited. 

2. Add the following paragraphs at the bottom of your document. 

 

 

 

 

3. Insert a Alphabet Quote Text Box. 

4. Copy the fifth paragraph and paste it inside the text box you inserted. 

5. Change the font, size, style and colour of your text inside the text box.. 

6. Change the alignment of text inside the text box. 

7. Format your text box. Change the Shape Fill, Outline and Effects of your text 
box. 

8. Drag the object and move it to the right side of your document. 

9. Save your work as ExxonMobil Final. 

Thank your for completing the activity. In this activity you have formatted a text box 
using the skills you have previously learned like formatting text and alignments. You 
have also learned to apply Shape Fill, Shape Outline and Shape Effects to your text 
boxes. 

 

Summary 

You have come to the end of Lesson 10. In this lesson you have 
learned to insert Text Box to your document. You have also learned 
to apply formatting techniques that you have used in other objects 
and applied it to your text box. 

 

 

 

 

NOW DO PRACTICE EXERCISE 10 ON THE NEXT PAGE. 

Activity 1:  Insert and Format Text Box 

“This project is ideally located to supply traditional long-term sales to 
customers in Japan China and Taiwan.” 
 
“The PNG LNG project provides accretive earnings per barrel yield and we 
continue to look at expansion opportunities for a third train, and there’s space 
for a fourth and fifth. 
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Practice Exercise  10 

 

A.  Follow the given instructions below. 

1. Open Michael Faraday document and a new blank document. 

2. In the new blank document create the following text boxes. Follow the 
format given below: 

 

 

 

 

 

 

 

 

 

 

 

 

3. Copy and paste the paragraphs from Michael Faraday document and 
paste it inside the text boxes. 

4. Drag the bottom part of the text box to make sure that all text are 
displayed inside the text box. 

5. Resize and/or move your text boxes to improve its appearance. 

6. Apply formats to your objects. Change the alignment of text and outline 
of the object. 

7. Save your work as Newsletter. 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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Answers to Activity 1 

The example shown here is just an example of what your work could look like. Your 
work may or may not look like the example below. 
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Lesson 11: Using the Page Setup Dialogue Box 
 

 

 

 

 

 

 

In Grade 9 Design and Technology - Computing, you have learned how to change 
the Margins, Paper Size and Orientation of your page documents in Lesson 9, 10, 
and 11 respectively. 

Also in our previous lessons, you have learned how to format text and objects placed 
in a document. Changing the Page Setup does not apply to text or objects in a 
document but on the document page itself.  

 

 

 

 

 

For these lessons you have used the ribbon to change your Page Setup. This time 
we will use the Page Setup Dialogue Box to edit our document. Before we start, open 
the document Malaria Report Edited. 

Follow the instructions below to change the Margins, Paper and Orientation: 
1. Click the Page Setup dialogue box icon. The dialogue box will appear. 
2. Make sure that the Margins tab is selected. Do not worry if the margins you 

have is different from the illustration here. You  can always change your 
margins any time you want. 

 

 

 

 

 

 

Page Setup 
dialogue box icon 

Your Aims: 
 define Page Set Up Dialogue Box 

 use the print preview to set up the document  
to be printed 

Welcome to Lesson 11 of Unit 2. In Lesson 10, you have 
learned to insert text boxes in your document. In this lesson, you 
will further increase your skills in changing the setup of your 
page. 
 

The Page Setup dialogue box. 

2 
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3. Change the Top and Bottom margins to 3 cm and the Left and Right 

margins to 2.54 cm.  If your computer uses inches ( ” ) as the unit of 
measurement, just type the number directly inside the the box followed by cm. 

 

 

 

 

 

4. Change the orientation to Landscape. Observe how the size of the top and 
bottom changes to that of 2.54 cm.  

 

 

 

 

 

 

 

 

5. Click the Paper tab and changed the paper size to A4. 

 

 

 

 

 

 

6. Click OK to apply changes to your pages. 

 
Change Page Setup using the Backstage View 
Backstage View contains frequently used commands in all Office 2010 software. This 
is located in the File tab. Perform the following task to change your page setup using 
the Backstage View. 
1. Click File  Print. Locate the Orientation, Paper size and Margins in the Print 

Preview option. 

Type the values directly inside 
the box followed by cm if the unit 
of measurement is in inches. 

The values inside immediately 
change when the orientation 
was changed. 

Paper tab  
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2. Click Page Orientation and 
change the orientation to 
Portrait. 

 

3. Click Paper Size option. This 
currently contains the type of 
paper the document is using. 
Choose A4. 

 

 

 

 

4. Click the Margins option. The 
Margins currently displays the 
custom margins we have set.  

5. From the options available, 
choose Narrow. Observe how 
each changes are immediately 
applied to your document  and 
displayed in the Preview. 

 

 

 

To change the Orientation, Paper 
size and Margins of your document. 
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You can also go directly to the Page Setup dialogue box.  

 

 

 

 

 

 

 

 

 

 

 

6. Use the tabs to make changes to your Page Setup. 

7. Print your work. Before you print select the name of printer to be used and 
Click Print. Your print out will be using the Page Setup you applied in the Print 
Preview options. 

 

 

 

 

 

 

8. The Print Preview closes after you click Print.  

9. Save your work as Malaria Report v3. 

  

Click to send your work to the printer. 

Page Setup 
dialogue box 
will appear 
when you 
click Page 

Setup.  
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1. Open document ExxonMobil Final. 

2. Use the following specification to change the Page Setup of your document. 

Orientation : Landscape 

Margins :  Wide 

Size  : A4 

3. Move your text box to the upper right side of your document. 

4. Save changes to your work. 

Thank you for completing this activity. In this activity you have learned to  
successfully changed the margins, orientation and size of your document using the 
Print Preview. You have also learned to open to Page Setup dialogue box from the 
Print Preview to change the page setup of your document. 

 

Summary 

You have come to the end of Lesson 11. In this lesson you have 
learned how to use the Page Set Up Dialogue box to print preview 
your document. 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 11 ON THE NEXT PAGE. 

Activity 1:  Changing the Page Setup 
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Practice Exercise 11 

 

A. Follow the given instructions below. 

1. Open Newsletter document. 

2. Using the Page Setup dialogue box, change the following page setup 

Margins:  3 cm left, right, top and bottom 

Orientation:  Landscape 

Paper Size:  A4 

3. Observe that as you change the page setup setting, the text boxes will be 
disarranged.  

4. Move, changed, resize and adjust your document. Use the format below 
to present your document. 

 

 

 

 

 

 

 

 

 

 

 

5. Use the Clipboard when cutting and pasting text inside the text boxes. 
You have learned to use the Clipboard in Lesson 3 Grade 10 Design and 
Technology – Computing. 

6. Save your work as Newsletter 2. 

 

 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.  
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Answers To Activity 1 

 Your work will look like the example below. 
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Lesson 12: Using the Print Dialogue Box 
 

 

 

 

 

 

 

Printing is usually the last step in preparing your document. Creating a hard copy of 
your work is the next thing to do after creating your document. However, printing 
documents immediately is not a good practice. Using Print Preview allows users to 
proofread the documents before final priting. In Lesson 6 of Grade 9 Design and 
Technology – Computing, you had learned how to use Print Preview.  Let us review 
on how to use print preview. 

Follow the steps below on using print preview. 
1. Open the document Malaria Report Edited. 

2. Click File  Print. The print options and print preview appears on  your 
screen.  

 

 

 

 

 

 

 

 

 

 

 

 

Zoom In and 
Zoom Out 

Scroll 
bar 
and 
scroll 
button 

Zoom In and 
Zoom Out 

Print Preview displays what 
your document will look like 
before printing. 

Your Aims: 
 identify the process on how to print a document 

 print whole document or selected parts of a 
document   

 

Welcome to Lesson 12 of Unit 2. In Lesson 11, you have learned 
how to use the Page Setup Dialogue box. In this lesson you will 
learn how to print using the Print Dialogue box.  
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3. Use Zoom In and/or Zoom 

Out to view the entire or 
portions of the page. 

 

 

4. Use the scroll button or scroll bar to view 
the pages of the document. 

 

 

 

 

 

 

5. Click the Previous Page and/or 
Next Page to move between 
pages of the document.  

 

6. Click the Printer option and select the name of the printer you are going to 
use. 

 

 

 

 

 

 

 

7.   Indicate the number of copies and click print. 

 

 

 

 

Scroll bar 

Scroll button 

Zoom Out Zoom In 

Previous page 

Next page 

Click up or down to 
indicate the number of 
copies to be printed. 
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1. Click File  Print. 

2. Click the arrow or type 3 in the Copies window. 

3. Click Print. This will print your work. By default, all of your print out will be 
Collated. This means your print out will be printed in three sets of page 1, 2 
and 3. 

 

 

 

 

 

 

4. Click the down arrow and choose Uncollated. 

 

 

 

 

 

5. Print three (3) copies of your document. 

Thank you for successufully completing this activity. In the activity you have  
successfully printed multiple copies of your document and change the arrangement 
the pages when printing.  

 

Printing Selected Parts of Document 
After checking and making sure that everything is in order from the Print Preview, it is 
now time to print your work. You can review on your printing skills from Lesson 5 and 
6 in Grade 9 Design and Technology – Computing.  

This lesson will guide you through printing your document and add a new concept of 
printing. Follow the steps below to print selected parts of the document: 

1. Close the print dialogue box. 

Activity 1:  Use Collated Print to print your document. 
 

Click to choose 
other option. 
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2. Highlight any paragraph in the document. 

3. Click Print  Setting and choose Print Selection. 

 

 

 

 

 

 

 

 

4. Click Print. Observe that only the highlighted paragraphs are printed. 

5. Click File  Print. 

6. Click Previous Page/Next Page to display Page 2 in the Print preview area. 

 

 

 

 

 

7. Click Print. Observe that only Page 2 will be printed. 

8. Click File  Print. 

9. From Settings options, choose Print Current Page.  
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10. The cursor will be placed in the Pages window, type 3.  

 

 

 

 

11. Click Print. Only page 3 of your document should be printed. 

 

 

 

 

1. File  Print. 

2. Type 1,3 in the Pages window. 

3. Print your work.  

Thank you for completing this activity. In this section, you have learned to print 
selected pages of your document. This will allow you to control pages of your text to 
be printed and not print the entire document for certain parts of your document. 

 

Print Output 
Observe how your printer uses your paper for printing. By default the printer will 
continously use the paper in the printer tray to print your document. If your document 
is 3 pages, this means that your document will use the same number of paper. You 
can also print your document on both sides of your paper but this depends on the 
type of printer you are using. 

Follow the instruction to print on both side of the paper. 
1. Print One Sided is the default setting of the printer. This means your 

document will be printed on one side of the paper. This is how your 
documents were previously printed. 

 

 

 

 

 

 

Activity 2:  Print Selected Pages of your document. 
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2. Click the arrow to display Manually Print On Both Sides. The computer will 

display a window asking you to place unprinted side of your document inside 
the paper tray of your printer. 

 

 

 

 

3. Click Print. 

 

Summary 

You have come to the end of Lesson 12. In this lesson you have 
learned how to use the Print Dialogue to select your printer and 
change the setting of your document before printing.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click to display 
other option 

NOW DO PRACTICE EXERCISE 12 ON THE NEXT PAGE. 
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Practice Exercise  12 

 

Follow the given instructions below. 

1. Open the document Malaria Report Edited. 

2. Print the following. 

A. Print 2 copies of the document. 

B. Print 2 copies of page 3. 

C. Print 2 copies of page 2 and 3. Make the same pages printed together. 

D. Print page 1 and 3 using one paper only. 

 

 

 

Answers To Activity 1 

A. Your first set of printout will be 3 sets of print out from Page 1 – 3.  

 

 

 

 

 

 

 

B. Your second set of printout will print the following pages 

 

 

 

 

 

 

Page 1 Page 3 Page 2 

All Page 1 will be printed together. 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 
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Answers To Activity 2 

Your print will look like the examle below. 

 

 

 

 

 

 

 

followed by all Page 2 … 

then all Page 3 will be printed last. 

Page 1 Page 3 
and 
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Answers to Practice Exercises in Topic 2 

 

Practice Exercise 7 

Rubric to assess your work 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform 
1. A three-page document should be saved. This could be an 

essay that you wrote or an article copied from any publication. 
 

2. Change the appearance of text by formatting (font type, size, 
colour) and/or use of Styles. 

 

3. The first page must contain the name of your essay and your 
name. It must not have any header or footer.  

 

4. Page 2 and 3 of your document must show the name of the 
essay, your name and page number in either the header or 
footer. 

 

5. Your document must be saved with the filename of the essay 
you wrote or the article you copied.  

 

The example below is a draft of what your document could look like. Do not worry 
your work look different.  

 

 

 

 

 

 

 

 

 

Perform the following task to check your work! 
1. Type your essay. This could be an original work or copied text from 

newspaper, magazine or any publication. 
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2. Click Insert  Header or Footer  choose from any built-in header and footer 

style. 

3. Type your text for the Header and/or Footer. 

4. Click Different First Page in the Design Tab of your Header and Footer 
Tools. Page 1 contains only the name of your essay and should not have any 
header and/or footer. Page 2 and 3 should have the header and/or footer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Practice Exercise 8 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform: 
1. Document must be saved as Advance Formats  
2. Format for the following must be set: 

Title: Elephant, 36 pts, Centre align. 
Sub-title: Perpetua, 28 pts, Centre align. 
Paragraphs: Century School, 12 pts, Justified 
Reference: Century School, 12 pts, Bold, Italic, Right align. 
Indention: First line of all the paragraphs. 

 

Header 

Footer 
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3. Title must start at the beginning of the paragraph to the end of 

the paragraph. 
 

4. Sub-title should not be more than one line paragraph.  
5. The entire document must be more than one page.  

Your work should look like the example below. The example below does not reflect 
the color, effect or fill of your work. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following steps were done to perform the exercise.  

1. Fonts group and Paragraphs group were used to change the font format and 
alignment of the title, sub-title, paragraphs and reference.  

 

 

Title 

Sub-
title 

Reference 

Pa
ra

gr
ap

hs
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2. Tab was used to indent the first line of all the paragraphs. 

3. Scale and Spacing the of the title, sub-title, and paragraphs were changed  
using Advanced font format. 

 

 

 

 

 

 

4. Your work must be saved as Advanced Formats document. 

 

Practice Exericise 9 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform: 
1. Document was saved as Michael Faraday.  
2. Title 1 & Title 2 were converted to WordArt  
3. Text Fill, Text Outline and Text Effects were applied to Title 1&2  
4. Printed copy must be submitted.  

Your work may or may not look like the example on the next page.  The example 
below does not reflect the color, effect or fill of your WordArt. 

 

 

 

 

Select a 
bigger Scale 
and/or adjust 
the Spacing 
of the text for 
the title. 
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Practice Exericise 10 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform: 
1. Four text boxes were created (Title, Sub-title, and 2x paragraph 

text boxes) 
 

2. Title, sub-title and paragraph texts were copied from Michael 
Faraday document. 

 

3. All or any of the text boxes were formatted using the following: 
 Change Text Direction 
 Change outlines of the objects 
 Apply Shape Fill 

 

 

4. Document must be saved as Newsletter document  
 

Your work may or may not look like the example on the next page. The example on 
the next page does not reflect the color, effect or fill of your text box. 
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Practice Exericise 11 

Rubric to assess your work. 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 
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Task to perform: 
1. Page Setup were changed: 

Margin: 3 cm left, right, top and bottom 
Orientation: Landscape 
Paper Size: A4 

 

2. Text boxes were moved, resized, and adjusted to fit in the new 
Page Setup setting. 

 

3. Work is saved as Newsletter 2  

Your work may or may not look like the example below. The example below does not 
reflect the color, effect or fill of your WordArt. 

 

Practice Exericise 12 

Categories for 
marking 

Not acceptable 
expectations 

(1 mark) 

Below 
expectations 

(3 mark) 

Meets 
expectations 

(5 marks) 

 
Score 

Assessment 
Criteria 

Task 
component not 
done 

Task 
component 
partially done 

Task 
component 
done 
confidently and 
properly 

 

Task to perform: 
1. 2 copies of Page 1, 2 and 3 will be printed.  
2. 2 copies of Page 3 only will be printed.   
3. 2 copies of Page 2 and 3 will be printed.  
4. Both Page 1 and 3 will be printed together in one page.  



GR10 D&T – COMPUTING U2 130 ANSWERS TO TOPIC 2 
 
The following steps were used to complete the task. 

A. File Print  Print Selection  2 copies  Print 

 

 

 

 

 

 

 

B. File  Print  Type 3 inside Pages window  2 copies  Print. 

 

 

 

 

 

C. File  Print  Type 2-3 or 2,3 inside Pages window  2 copies  Print. 

 

 

 

 

 

 

 

 

 

D. File  Print  type 1,3 inside Pages window  2 Page Per Sheet. 
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End of Topic 2 
 

Now Do Exercise 2 in Assignment Book 2 Then Go to Topic 3. 
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TOPIC 3 

 
 
 
 
 

UNIT 2 
 
 
 
 

TABLES AND LISTS 
  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Lesson 13: Inserting, Adding and Deleting Tables 
Lesson 14: Sizing Rows and Columns 
Lesson 15: Applying Changes to Boarders and Shading 
Lesson 16: Using Auto Sum and Sort Options  
Lesson 17: Using Bulleted and Numbered Lists 
Lesson 18: Formatting Lists  
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TOPIC 3: TABLES AND LISTS 
 

In this topic you will learn about using tables and lists to your documents. The Topic 
is designed to familiarise you with how to efficiently use tables and list.  

In this topic, you will study about the following: 

Lesson 13  inserting, adding and deleting focuses on inserting, adding and deleting 
tables in the document. 

Lesson 14  changing the size explains how to change the size of rows and columns 
in a table inserted or added into the document. 

Lesson 15 applying borders discusses how to apply borders and shading to 
inserted or added tables to your document. 

Lesson 16 using auto sum and sort explains how to use Auto Sum and Sort 
options in tables. 

Lesson 17  using bullets and numbering discusses how to use bullets and 
numbered list in the document 

Lesson 18  formatting lists in documents explains how format list in the document. 

By the end of Topic 3, you should be able to use more advanced word processing 
skills and techniques, create quality word processed documents and demonstrate 
knowledge and skills on efficient use of word processing procedures. 
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Lesson 13: Inserting, Adding and Deleting Tables 
 

 
 
 
 
 
 
 
 
 
Tables 
A table is a grid of cells arranged in rows and columns. Grade 9 Design and 
Technology-Computing Lesson 18 describes a table as very effective way of  
presenting information as it organizes information for a reader and reduces long 
words to be read in order to interpret a data. It provides alternatives to using tabs and 
makes it easier to present paragraphs of text side by side in documents such as 
resumes and brochures. Moreover, tables can be customized and are useful for 
various tasks such as presenting text information and numerical data. 

The above information clearly describes a table and spells out its importance in MS 
Word document.  

Inserting and Adding Tables 
Tables are a useful way of arranging information on a page. In their simplest form, 
tables can be used to place information in lists. More complex tables can be used to 
arrange graphics on a page and can also include calculations. Tables are inserted in 
any part of the document by placing the cursor to its desired location. After 
performing series of steps then one can successfully add the intented table to its 
desired location in the document. There are a few ways to insert and add a table. 
Study each of the following ways. 

A. Using the Table Icon from the Insert Tab on the Ribbon 
 Follow the steps below on how to use the Table Icon from the Insert Tab on 
 the Ribbon. 

1. Place your cursor or insertion point where you want to insert a table. 

2. Click the Insert tab. 

3. Click Table button. This will display a simple grid shown in the next page. 
When you move your mouse over the grid cells, it makes a table appear 
in the document. However your mouse over the diagram squares to 
select the number of columns and rows in the table.You can make your 
table having desired number of rows and columns. 

Welcome to Lesson 13 of Unit 2. In Lesson 12, you have learned 
how to print your document . In this lesson you shall learn how to 
insert, add and delete tables in your document.  
 
 Your Aims: 

 differentiate inserting, adding and deleting 
tables  

 perform the steps in inserting, adding and 
deleting tables  

 determine the importance of using tables 
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4. Click your mouse, and the table appears in the document. 

5. You can now place the insertion point anywhere in the table to add text. 

6. Repeat the process until you become comfortable doing it. 

 

B. Using the Insert Table Dialogue Box 
 Follow the steps below on how to use the Insert Table dialog box. 

1. Place your cursor or insertion point where you want to insert a table. 

2. Click the Insert tab. 

3. Click Table button.  

4. Hover your mouse down the dialog box and select Insert Table. 
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5. The Insert Table dialog box appears. Decide how many rows and 
columns the table would have by entering a value inside the box or 
clicking the up and down arrows after the box. 

 
 
 
 
 
 
 
 
 
 
 
 

6. Click OK, and the table appears in the document. 

7. You can now place the insertion point anywhere in the table to add text. 

8. Repeat the steps until you become comfortable doing it. 

C. Using the Table Drawing Tools 
 Follow the steps below on how to use the Table Drawing Tools. 

1. Place your cursor or insertion point where you want to insert a table. 

2. Click the Insert tab. 

3. Click Table button.  

4. Hover your mouse down the dialog box and select Draw Table. 
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5. When you move the pointer over the document, you should note that it 
has the shape of a pencil.  

6. Click and drag diagonally down and to the right to create a rectangle. 

 
7. With the pencil, draw a line that divides the rectangle in two.  

8. Use the pencil to divide one of the halves into two columns. 

 
9. Now that you can see the flexibility of the Draw Table feature, use it to 

create and divide more boxes. 

10. Click the Eraser tool.  

 

 

11. Go back to the table and erase one of the lines you created by clicking 
and dragging along the line. Press ESC to cancel the eraser tool. 

 
 
 
 
 
 
 

11 



GR10 D&T - COMPUTING U2          138       TOPIC 3 LESSON 13 
  
Deleting Tables 
Tables can be deleted by following the steps below. 

Using Right Click 
1. Highlight the table by clicking the four edged arrow square at the top right side 

of the table. 
 
 
 
 
 
 

 
2. Right click your mouse and a context menu will appear. Select Delete Table 

and the table will be deleted from your document.  
 

3. Repeat the steps until you become competent in it to get the desired result. 

 
Using the Layout Tab 
Follow the steps below on how to use the Layout tab. 
1. Click anywhere in the table you want to delete. The cursor will be placed in the 

cell that you selected. 

 
2. Click the Layout tab then click Delete Table option under the Delete Table 

Button to completely delete the table from the document along with its 
content.  

Table Select 

2 

The cursor 
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3. Repeat the process until you become comfortable doing it and get the desired 
result. 

 

 
 
 

1. List three importance of using tables in a MS Word document. 
a. __________________________________________________________

__________________________________________________________ 

b. __________________________________________________________

__________________________________________________________ 

c. __________________________________________________________

__________________________________________________________ 

2. What tab is used when you want to insert a table using the ribbon? 
___________________________________________________________ 

3. What command will you use if you want to create a table using drawing tools? 
___________________________________________________________ 

4. Where can you find the Delete Table option? 
 ___________________________________________________________ 
 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

Activity 1:  Answer the following questions. 
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Summary 
You have come to the end of Lesson 13. In this lesson you have 
inserted, added and deleted tables to your document. You have also 
learned the importance of using tables in your document. 

 

 
 
 
 
  

NOW DO PRACTICE EXERCISE 13 ON THE NEXT PAGE. 
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Practice Exercise 13 
 

Perform the following task. 
1. Create a 5x4 table (5 columns and 4 

rows) using the Insert  Table options. 
2. In the same document create a 3x2 table 

(3 columns and 2 rows) This time use the 
Insert Table dialogue box. 

 
3. Draw a 3x2 table. Use the Draw Table 

option. 
 

4. Save your work as 3 Table Exercise. 
 
 
 
 

 
 
 
 
Answers to Activity 1 
1.  

a. Tables are very effective for presenting information as  it organizes 
information for a reader and reduces long words to be read in order to 
interpret a data.  

b. Tables provide alternatives to using tabs and make it easier to present 
paragraphs of text side by side in documents such as resumes and 
brochures. 

c. Tables can be customized and are useful for various tasks such as 
presenting text information and numerical data. 

2. Insert Tab 

3. Draw Table 

4. Delete Table button 

 

 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 3.  

2 

3 

2 



GR10 D&T - COMPUTING U2          142       TOPIC 3 LESSON 14  

Lesson 14: Sizing Rows and Columns 
 

 
 
 
 
 
 
 
 
 

Rows and Columns 
As discussed in Lesson 13, a table is a grid of cells arranged in rows and columns. 
Columns are the vertical lines and rows are the horizontal lines which intersect to 
create the cells in a table. 

  

  

  

 
MS Word table can contain as many as sixty-three (63) columns but the number of 
rows is unlimited. Managing tables involves selecting a part of the table and carrying 
out the required action. Sizing the rows and columns enables you to adjust the 
column width and row height according to a definite purpose or need. This offers 
flexibility to manipulate columns and rows to serve well its intended purpose which is 
to organize information for a reader in order to interpret a data.  

Selecting a Cell, Row, Column or Entire Table 
Before you can size rows and columns, you must learn first how to select these. 
Follow the steps below to select a cell, row, column or an entire table. 

To select a cell, follow the steps below to select a cell. 
1. Move your mouse to a point just inside the left edge of the cell so your mouse 

pointer changes to a black arrow shape.  

2. Click to select one cell or drag to select several cells.  

 
 
 
 
To select a row, perform the the following task to select a group of rows. 

Welcome to Lesson 14 of Unit 2. In Lesson 13, you have learned 
how to insert, add, and delete tables in you document. In this lesson 
you shall learn how the definition of rows and columns and how to 
size and resize them. Moreover, you will learn the importance of 
sizing rows and columns. 

Your Aims: 
 define rows and columns 
 perform the steps on sizing rows and columns 
 determine the importance of sizing rows and 

columns 

Column 

Row 

A highlighted cell indicating that the cell selected. 
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1. Place the cursor to the left of the row observe how it changes to an arrow. 

 

2. Click the left mouse button. 

 

To select a column, do the following task to select a column. 
1. Place the cursor above the column (it changes to an arrow pointed 

downwards). 

 
2. Click the left mouse button.  

3. You can click to select a column or drag to select multiple columns.  

 

 

To select an entire table, perform the task below:  
1. Place the cursor at the top left corner of the table (the cursor changes to a 

cross with an arrow on each end). 

 
2. Click on it to select the entire table. 

3. Repeat the whole process until you are competent in it so that you get the 
desired result. 

 
 
 
 

1 

1 

Click and drag the mouse when the arrow is displayed.  

Table Select 
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Sizing Rows and Columns 
In changing the column width and changing the row height there are two ways on 
how rows and columns can be sized. Follow the steps below on how to size rows and 
columns. 

Changing Column Width 
Follow the steps below, to change the column width. 
1. Click and hold the mouse on one of the vertical lines on the boundary of the 

column. 

2. Drag the column to the desired position. 

 
 
 

3. Repeat the whole process until you are competent in it so that you get the 
desired result.  

You can also do this to change column width. 

1. Click the column.  

2. Right click on the mouse and select Table Properties. 

 
3. Choose the Column tab. 
4. Set the width and click OK after setting the width. 

 
 
 
 

Click, hold and drag to adjust the column width. 
C 

2 
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5. Repeat the whole process until you get the desired results and feel 

comfortable doing it. 

Changing Row Height 

Follow the steps below on how to change the row height. 
1. Click and hold the mouse on one of the horizontal lines on the boundary of the 

column. 

2. Drag the column to the desired position. 

 
You can also do this to change row height. 

1. Click in the row.  

2. Right click on the mouse and select Table Properties. 

3. Choose the Row tab and set the width. Then click OK. 
 
 
 
 
 
 
 
 
 

3 

4 
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4. Repeat the whole process until you get the desired results and feel competent 
doing it. 

 

 
 
 

1. Explain the importance of sizing rows and columns of a table in a MS Word 
document. 
______________________________________________________________

______________________________________________________________ 

2. After doing the right click, what command tab is used when you want to size 
rows and columns? 
___________________________________________________________ 

3. What command will you use if you want to adjust column width? 
___________________________________________________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 

Summary 
You have come to the end of Lesson 14. In this lesson you have 
changed the sizes of rows and columns of tables to your 
document. You have also learned the importance of sizing rows 
and columns of tables in your document. 

 

 
 
 
 
 
 
 
 
 
 
 

Activity 1:  Answer the following questions. 
 

NOW DO PRACTICE EXERCISE 14 ON THE NEXT PAGE. 
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Practice Exercise  14 
 

Create a table and set its properties. 
1. Create a table with 3 columns and 3 rows. 

2. Type the following data inside the table you created. 

Names of 
Respondents 

Billing Address Comments 

Corazon Marciana 
Ilumminada 
Concepcion 

 113 Southwoods Park 
Avenue , Calamba, 
Laguna 

Respondent does not 
have any sons or 
daughters but lives with 
three nieces  and two 
nephews 

Maria Isabel 
Constantino 
Guevarra 

945 Mc Arthur 
Driveway International 
Paete, Laguna 

Respondent is living with 
her three sons and five 
daughters 

 
3. Set table properties. Use 0.3” row height and 2.08” column width. Your setting 

will change to centimeter depending on the unit of measurement used in your 
computer. 

4. Save your work as Table Properties Exercise. 
 

 

 
 
 

Answers to Activity 1 
1. Sizing the rows and columns enables you to adjust the column width and row 

height according to a definite purpose or need. This offers flexibility to 
manipulate columns and rows to serve well its intended purpose which is to 
organize information for a reader in order to interpret a data.  

2. Table Properties 

3. Column Tab 

 
 
 
 
 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 3.  
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Lesson 15: Applying Changes to Borders and Shading  
 
 
 
 
 
 
 
 
 
 
 
 

Borders and Shading 
Microsoft Word allows you to place a border on any or all of the four sides of a table 
very similar to text, paragraphs, and pages. You can also add many type of shading 
to table rows and columns. This lesson will teach you how to add any of the borders  
(left, right, top or bottom) around a table and how to add different shadows to various 
rows and columns of the table. 
Adding and changing borders and shadings of a table can achieve the following 
results: 

1. The table will look more interesting and professionally looking. 

2. The table with borders and shadings can make the data inside it stand out to 
relay the information better. 

Add Borders To Table 
Follow these simple steps to add borders in a table cell available in MS Word 
document. 
1. Select the table to which you want to add border. In Lesson 14 you learned 

how to select a table by clicking over the table anywhere which will make a 
Cross Icon visible at the top-left corner of the table. Now, just click this cross 
icon to select the table. 

 

2. Click the Border Button to display a list of options to put a border around the 
selected table. You can select any of the options available by simply clicking 
over it. 

Welcome to Lesson 15 of Unit 2. In Lesson 14, you have learned 
about the definition of rows and columns, how to size and resize 
and learned the importance of sizing and resizing them. 
In this lesson, you will learn about table borders and shading. 
 

Your Aims: 
 define borders and shading 
 perform the steps on changing table borders 

and shading 
 identify the importance of applying changes to 

borders and shading 
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3. Try to add and remove different borders like left, right top or bottom by 

selecting different options from the border options. 

 
4. You can apply border to any of the selected row or column. You can try it 

yourself. 

5. To delete the existing border, simply select No Border option from the border 
options. 

6. Repeat the whole process until you get the desired results and feel confident  
doing it. 
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Using Border Options 
You can add borders of your choice to word table by following the simple steps given 
below. 
1. Click the Border Button to display a list of options to put a border. 

Select Border and Shading option available at the bottom of list of the 
options as shown in above screen capture. This will display a  Border and 
Shading dialogue box. This dialog box can be used to set borders and 
shading around a selected table. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Click Border tab which will display a list of border settings, styles and options 

whether this border should be applied to the table or text or paragraph. 
3. You can use Preview section to disable or enable left, right , top or bottom 

borders of the selected table or row or column. Follow the given instruction in 
preview section itself to design the border you like. 

4. You can customize your border by setting its colour, width by using different 
width thickness available under style section. 
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5. Repeat the whole process until you get the desired results and feel confident 
doing it. 

 
Add Shades To Table 
Follow these similar steps to add shades on a selected table or its rows or columns. 
1. Select a row or column where you want to apply shade of your choice. 

 
2. Click the Border Button to display a list of options to put a border. 

Select Border and Shading option available at the bottom of list of the 
options. This will display a Border and Shading dialog box. This dialog box 
can be used to set borders and shading around selected row(s) or column(s). 

 
3. Click Shading tab which will display options to select fill, color and style and 

whether this border should be applied to cell or table or selected text. 
4. You can use Preview section to have an idea about the expected result. Once 

you are done, click OK button to apply the result. 
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5. Repeat the whole process until you get the desired results and feel confident 

doing it. 
 

 
 
 

1. List two importance of adding and changing borders and shading to a table in 
a Word document. 
______________________________________________________________

______________________________________________________________ 

2. What command button is used when you want to add or change borders and 
shadings of a table? 
___________________________________________________________ 

3. What tab will you use if you want to add fill, colour and style to your table? 
___________________________________________________________ 

 
 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 
 
 
 

Activity 1:  Answer the following questions. 
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Summary 
You have come to the end of Lesson 15. In this lesson you have 
changed the borders and shadings of tables to your document. 
You have also learned the importance of adding and changing the 
borders and shadings of tables in your document. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 15 ON THE NEXT PAGE. 
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Practice Exercise 15 
 

1. Create a table as shown below. 

   

   

   

  

   

  

   

  

   

   

   

   

 
2. Apply borders and shade to to columns and rows.  
3. You can also choose your own colours for the borders and shade of your table. 
4. Save your work as Borders and Shade Table. 
 

 
 
 
 
Answers to Activity 1 
1.  

a. The table made will look more interesting and professionally looking. 

b. The table with borders and shadings can make the data inside  it  stand out 
to relay the information better. 

2. Border button 

3. Shading tab 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 3. 
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Lesson 16: Using Auto Sum and Sort Options 
 
 
 

 
 
 
 
 

 
 
 

Auto Sum  
Microsoft 2010 provides a great feature of using tables along with document content 
to complement and summarize it in a better way, but sometimes in tables we also 
need to write the formula for evaluation of values. Altough it does not support a wide 
range of formulas, we can use basic formulas that will be sufficient for most users.  
You can perform calculations and logical comparisons in a table by using formulas. 
The Formula command is found on the Table Tools Layout tab in the Data Group. 
  

 
 
Auto Sum function as defined in Grade 9 Design and Technology-Computing Unit 4 
Lesson 17 is a function in a Spreadsheet program which inserts a formula in the 
selected cell that adds the numbers in the column above it. It sets the range of cells 
by looking for numeric data above the selected cell. 

Adding calculations to a table in Word is very similar to adding calculations in a 
spreadsheet program such as MS Excel. One difference is that the formula used for 
the calculation is not entered in to the table directly. Another difference is that Row 
and Column references are not shown on a table. 

In MS Word 2010, Auto Sum can be achieved by using the Formula command. Sum 
numbers in a table can be done by using any of these positional arguments (LEFT, 
RIGHT, ABOVE, BELOW). You can also use positional arguments (LEFT, RIGHT, 

Welcome to Lesson 16 of Unit 2. In Lesson 15, you have learned 
the definitions of border and shading, how to change them and 
their importance. In this lesson you will learn the use of Auto Sum 
and Sort options. 
 Your Aims: 

 define Auto Sum   
 define Sort options 
 perform the steps on using Auto Sum and Sort 

options 
 determine the importance of using Auto Sum 

and Sort options 

Table Tools Layout 
Tab 

Formula  
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ABOVE, BELOW) with these functions: AVERAGE, COUNT, MAX, MIN a 
PRODUCT. 

 
Auto Sum enables evaluation of values in a table in Word document. This provides 
more data to deliver the needed information to the user or reader of the document. 

 
 
 
Using the Formula Command 
To avoid any error while summing in a table by using positional arguments, type zero 
(0) in any empty cell that will be included in the calculation. Follow these steps on 
how to sum using positional arguments. 
1. Create a table with 3 columns and 4 rows. Type the data as shown below. 

Student Class Standing  Exam Mark Total  

Mario 28 32  

Chelsea 41 30  

Bart 21 25  

 
2. Select the table where you want your result. If the cell is not empty, delete its 

contents. In this example select the cell just below Total. 

Student Class Standing  Exam Mark Total  

Mario 28 32  

Chelsea 41 30  

Bart 21 25  

 
3. On the Table Tools Layout tab in the Data group, Click Formula. Upon click, 

Formula dialog box will appear. Under Formula, =SUM(ABOVE) is 
automatically inserted. If so, delete this and proceed to Step 3. 

 
4. Now, in the Formula dialogue box, type one of the following formula as 

applicable: 

To Add the Numbers Type this in the Formula Box 

The Table Tools Layout does not appear unless a table is created.  
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Above the Cell =SUM(ABOVE) 

Below the Cell =SUM(BELOW) 

Above and below the Cell =SUM(ABOVE,BELOW) 

Left of the Cell =SUM(LEFT) 

Right of the Cell =SUM(RIGHT) 

Left and Right of the Cell =SUM(LEFT,RIGHT) 

Left of and Above the Cell =SUM(LEFT,ABOVE) 

Right of and above the Cell =SUM(RIGHT,ABOVE) 

Left of and Below the Cell =SUM(LEFT,BELOW) 

Right of and Below the Cell =SUM(RIGHT, BELOW) 

  

 
For the given example below, =SUM(LEFT) is applicable to get the total sum of 
Mario’s marks. 

 
5. Click OK. 

The sum will be displayed in the selected cell. Try to do the same for Chelsea 
and Bart by following steps 1-4. 
 

Student Class Standing  Exam Mark Total  

Mario 28 32 60 

Chelsea 41 30  

Bart 21 25  

 
6. Repeat the whole process until you get the desired results and feel confident 

doing it. 
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1. Create a table just like the example below. 

Names Cans Plastic Bottles Newspapers 

John 12 23 41 10 

Maria 56 15 23 42 

Total     

 
2. Sum the total number of cans, plastics, bottles and newspapers collected by 

John and Maria. Use any one of the formulas discussed in the previous 
lesson. 

3. What is the importance of using Auto Sum? 
______________________________________________________________

______________________________________________________________

______________________________________________________________ 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

 
Sorting Options 
Sorting as defined in Grade 9 Design and Technology-Computimng Unit 4 Lesson 12 
is a common Spreadsheet task that allows you to easily reorder your data. The most 
common type of sorting is alphabetical ordering, which you can do in ascending or 
descending order. This definition holds true even in MS Word application. 

Sorting in MS Word table is important as the information can easily be sorted in 
whatever order suits you and your purpose.  

To sort a table you need to first do the following.  

1. Create a table like the one shown below. 

Student names Class Standing Exam Marks Total 
Zeny 21 32 53 
Clara 15 28 43 
Susan 20 39 59 
Mario 32 26 58 
Athena 35 42 77 

Activity 1:  Do the following. 
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Giorgio 26 37 63 
Helthea 30 43 73 
Keana 16 29 45 

 
2. Click in the table. If you do not intend to sort the entire table, then you will 

need to select the parts you want to be sorted.  

 
3. From the Table Tools Layout menu select Sort. The sort dialogue will 

appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 

4. Make sure the options are the same as the example above and click OK. The 
list will now be sorted in order of the Student column. 

 
 

Table Tools Layout 
Tab 
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Student Names Class Standing Exam Marks Total 

Athena 35 42 77 

Clara 15 28 43 

Giorgio 26 37 63 

Helthea 30 43 73 

Keana 16 29 45 

Mario 32 26 58 

Susan 20 39 59 

Zeny 21 32 53 

 
5. Repeat the above steps to sort the list by the Total column in Descending 

order. 

   
The table now will be sorted according to the Total column in a descending order. 

Student Names Class Standing Exam Marks Total 

Athena 35 42 77 

Helthea 30 43 73 

Giorgio 26 37 63 

Susan 20 39 59 

Mario 32 26 58 

Zeny 21 32 53 

Keana 16 29 45 

Clara 15 28 43 
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1. Create a table just like the example below. 

Student Recitation Quiz Assignment Total 

John 5 23 24 52 

Maria 6 15 23 44 

Socorro 7 26 20 53 

Teodoro 9 28 19 56 

Doroty 8 19 16 43 

 
2. Sort the table according to the following categories: 

a. Student column in Ascending order 
b. Total in Descending order 

3. What is the importance of using the Sort option? 
______________________________________________________________

______________________________________________________________

______________________________________________________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 

Summary 
You have come to the end of Lesson 16. In this lesson you have 
learned the definitions of Auto Sum and Sorting. You have also 
learned how to use them in tables in a MS Word document and their 
importance. 

 

 
 

 
 
 
 

NOW DO PRACTICE EXERCISE 16 ON THE NEXT PAGE. 

Activity 2:  Do the following. 
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Practice Exercise 16 
 

Follow the given instructions below. 
A. Auto Sum 

1. Create a table like the example below. 

Student Year Mark Exam Total 

Jenny 43 38  

Gweneth 36 37  

Thalia 40 40  

Joe 29 45  

Felix 47 39  

Adam 25 36  

Average 36.67 39.17 75.83 

 
2. Calculate the Total marks of each student by using the correct formula as 

discussed in the previous lesson. 
 
B. Sorting 

1. Using the table example above, select the entire table except for the 
Average row at the bottom.  

2. From the Table Tools Layout menu select Sort. The dialogue box will 
appear.  

3. Sort the table according to Student column in Ascending order. 

4. Repeat the above steps to sort the table by the Total column in 
Descending order.  

 

 
 
 
Answers to Activity 
Activity 1 
1. You work should look like the example given below. 
 
 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 
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2. Your table should contain the following total. 

Names Cans Plastic Bottles Newspapers 

John 12 23 41 10 

Maria 56 15 23 42 

Total 68 38 64 52 

3. Auto Sum enables evaluation of values in a table in MS Word document. This 
provides more data to deliver the needed information to the user or reader of 
the document. 

 
Activity 2 
1. You work should look like the example given below. 
 
 
 
 
 
 
 
2.  Once your table is sorted, your sorted table should look like the example 

below:  
 a. Student column sorted in Ascending order 

Student Recitation Quiz Assignment Total 

Doroty 8 19 16 43 

John 5 23 24 52 

Maria 6 15 23 44 

Socorro 7 26 20 53 

Teodoro 9 28 19 56 

b.  Total column sorted in Descending order. 

Student Recitation Quiz Assignment Total 

Teodoro 9 28 19 56 

Socorro 7 26 20 53 

John 5 23 24 52 

Maria 6 15 23 44 

Doroty 8 19 16 43 

 
3. Sorting in MS Word table is important as the information can easily be sorted 

in whatever order suits you and your purpose.  
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Lesson 17: Using Bulleted And Numbered Lists  
 
 
 
 
 
 
 
 
 
 
 

Bullets and Numbered List 
Bullet lists are lists where each paragraph begins with a dot point. Numbered lists 
are lists where each item is ordered using a number. These lists can be customised 
in a number of different ways such as changing the symbol used for bullet points or 
changing a numbered list to use letters or roman numerals.  

Examples: 

Bullet list  List Using Symbol  Number List  List Using Letters  

• apple   � apple    1. apple   a. apple  

• banana  � banana    2. banana   b. banana  

• carrot   � carrot    3. carrot   c. carrot 

Bulleted and numbered lists can be used in your documents to format, arrange and 
emphasize text. In this lesson, you will learn how to modify existing bullets, insert 
new bulleted and numbered lists, select symbols as bullets, and format multilevel 
lists. 

 
Type an asterisk * symbol ([Shift] [8]) and press [Tab]. When you type an 
asterisk and then insert a tab before typing, Word will convert the 
completed paragraph in to a bulleted paragraph.  

 
To Create a List 
Follow the steps below on how to create a list. 
1. Type the following texts and format as a list. 

Green    Purple   Red 

Blue    Orange 

Welcome to Lesson 17 of Unit 2. In Lesson 16, you have learned 
the definitions of Auto Sum and Sort. You have learned how to 
use them and their importance. In this lesson you will learn how 
to use bulleted and numbered lists. 
 Your Aims: 

 define bulleted and numbered list 
 identify the correct use of bulleted and 

numbered lists 
 identify the steps on using bulleted and 

numbered list 
 determine the importance of using bulleted and 

numbered list 
 



GR10 D&T - COMPUTING U2          165       TOPIC 3 LESSON 17 
  
2. Click the Bullets or Numbering drop-down arrow on the Home tab. 

 

3. Select the bullet or numbering style you would like to use, and it will appear in 
the document. 

Numbering     Bullet 

1. Green      Green 

2. Blue      Blue 

3. Purple      Purple 

4. Orange     Orange 

5. Red      Red 

4. To remove numbers or bullets from a list, select the list and click the Bullets 
or Numbering commands. 

When you are editing a list, you can press Enter to start a new line, 
and the new line will automatically have a bullet or number. When 
you have reached the end of your list, press Enter twice to return to 

"normal" formatting. 
 

Bullet Options 
You can select any of the symbols as a bullet. Follow the steps below on how to have 
symbols as bullets. 
1. Select the existing list below. 

Bed     

Rest 

Nap 
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Pillow 

Relax 

2. Click the Bullets drop-down arrow. 

3. Select Define New Bullet from the drop-down menu. The Define New Bullet 
dialogue box appears. 

 
4. Click the Symbol button. The Symbol dialogue box appears. 

5. Click the Font drop-down box and select a font. The Wingdings and Symbol 
fonts are good choices as they have a large number of useful symbols. 

 
6. Select the desired symbol. 

7. Click OK. The symbol will now appear in the Preview section of the Define 
New Bullet dialogue box. 
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8. Click OK to apply the symbol to the list in the document. 
 

You can use a picture as a bullet. Click the Picture button in the 
Define New Bullet dialogue box, and then locate the image file on 
your computer. 

 
 

 
 
 
 

1. Type the following text as it is set. 

 

 

 

 

 

2. Copy and paste the text to create another set of paragraphs. 

3. Apply bullets to the first set of paragraphs, except for the title “Success Due to 
Many Factors”.  

4. Apply Numbers to the next set of paragraphs, except for the title. 

5. Save your work as Bullets and Numbers Activity. 

 

 

Activity 1:  Create a list by following the given steps. 
 

Success Due to Many Factors 

A significant market need for their vitamin supplement products. 

A significant deduction in operational costs. 

A well-detailed campaign advertisement. 
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Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

Summary 
You have come to the end of Lesson 17. In this lesson you have 
learned the definition of bullets and numbering. You have also 
learned how to use them and their importance. 

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 17 ON THE NEXT PAGE. 



GR10 D&T - COMPUTING U2          169       TOPIC 3 LESSON 17 
  
Practice Exercise  17 
 

A. Follow the instructions below to create a list using numbers and bullets. 
1. Create a new blank document.  

2. Enter the heading Colours, formatted as bold size 18 text.  

3. Type an asterisk * symbol (Shift 8) and press Tab. When you type an asterisk 
and then insert a tab before typing, Word will convert the completed paragraph 
in to a bulleted paragraph.  

4. After the tab type red and press Enter. As soon as you press Enter. Word will 
know the paragraph is ended and the paragraph will be automatically 
converted to a bullet point. A new bullet point on the following line will also be 
created. If this happens when you do not want a bulleted list to be created, 
you can undo straight away to undo the automatic change.  

5. Continue to type the list pressing Enter every after word. Type blue, pink, 
orange, green, puple and gray.  

6. After you have typed the last item in the list, press Enter twice. Pressing it a 
second time indicates that you are ending the list and the next paragraph will 
be normal.  

7. On the new line type Days of the Week. Format the text as bold and 18 point 
size.  

8. Type a number 1. then press Tab and then type Monday.  

9. Press Enter to complete the paragraph and it will be automatically formatted 
as a numbered list.  

10. Complete the list following step 9 for every word . Type Wednesday, 
Thursday, Friday, Saturday and Sunday. 

11. Press Enter twice to complete the list.  

12. Save the document as Practicing Lists.  

B.  What is the importance of using bullets and numbers in your document? 

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________ 

 

 
 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 
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Answers To Activity 

1. Open document Bullets and Numbers Activity you previously saved inside 
your computer. 

2. Your work should look like the example below  

Success Due to Many Factors 

 A significant market need for their vitamin supplement products. 

 A significant deduction in operational costs. 

 A well-detailed campaign advertisement. 

Success Due to Many Factors 

1. A significant market need for their vitamin supplement products. 

2. A significant deduction in operational costs. 

3. A well-detailed campaign advertisement. 

3.  The following steps were performed to create the example above. 

a.  In the first paragraph, highlight to select all three phrases. 

b.  On the Home tab, in the Paragraph group, click the Bullets button  
The text is converted to a bulleted list. 

c. In the second paragraph, highlight to select all three phrases. 

d.  With the list still selected, click the Numbering button  to create a 
numbered list. 
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Lesson 18: Formatting Lists 
 
 
 
 
 
 
 
 
 

Formatting List 
You have learned in Lesson 17 how to create a list by using either bullets and 
numbers. Formatting list enables you to do the following: 
a. Change the colour of the bullet colour. 
b. Create a multilevel list 
c. Change the level of a list 
Formatting would enable you to enhance appearance of the list you have created. It 
will also create the order of appearance of the items in the list according to your 
purpose.  

To Change the Bullet Colour 

You can enhance the appearance of the bullets that you use by changing the bullet 
colour. Follow the steps below on how to change the bullet colour. 

1. Type the list of words below.  

Dog  

Cat  

Mouse  

Horse  

Elephant 

Lamb  

Bird  

Ant 

Welcome to Lesson 18 of Unit 2. In Lesson 17, you have learned 
the definition of bullets and numbering. You have also learned 
how to use them and their importance. In this lesson you will learn 
how to format the list you have created in Lesson 17. 
Welcome to Lesson 14 of Unit 2. In Lesson 13, you have learned 
how to insert, add, and delete tables in your document. In this 
lesson you shall learn the definition of rows and columns and how 
to size and resize them. Moreover, you will learn the importance 
of sizing rows and columns. 
 
 
 

Your Aims: 
 perform the steps on formatting list 

 determine the importance of formatting list 
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2. Select the existing list. 
3. Click the Bullets drop-down arrow. 
4. Select Define New Bullet from the list. The Define New Bullet dialogue box 

appears. 
5. Click the Font button. The Font dialogue box appears. 
6. Click the Font Color drop-down box. 

 
 
 
 
 
 
 
 
 
 
 
 

7. Click on the desired colour to select it. 
8. Click OK. The bullet colour will now appear in the Preview section of the 

Define New Bullet dialogue box. 
 
 
 
 
 
 
 
 
 
 
 

9. Click OK to apply the bullet colour to the list in the document. 

 Dog  

 Cat  

 Mouse  

 Horse  
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 Elephant 

 Lamb  

 Bird  

 Ant 
 
Multilevel Lists 
Multilevel lists allow you to create an outline with multiple levels. In fact, you can turn 
any bulleted or numbered list into a multilevel list by simply placing the insertion point 
at the beginning of a line and pressing the Tab key to change the level for that line. 
You can then use the Multilevel List command to choose the types of bullets or 
numbering that are used like the example below. 

 

 
To Create a Multilevel List 
Follow the steps below on how to create a multilevel list. 

1. Create and select the text that you want to format as a multilevel list. 

2. Click the Multilevel List command on the Home tab. 

 
3. Click the bullet or numbering style you would like to use. It will appear in the 

document. 
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4. Position your cursor at the end of a list item and press the Enter key to add an 

item to the list. 

To remove numbers or bullets from a list, select the list and click the 
Bullets or Numbering commands. 

 
To Change the Level of a Line 
Follow the steps below on how to change the level of a line. 
5. Using the same list, place the insertion point at the beginning of the line. 

 
6. Press the Tab key to increase the level. 

 
7. Hold Shift and press Tab to decrease the level. 

8. Repeat the whole process until you get the desired results and feel 
comfortable doing it. 

 

 
 
 

1. Refer to the jumbled steps below on how to change bullet colour. 

i. Click OK. 

ii. Choose Font 

iii. Slect Define New Bullet 

iv. Choose Font Color 

If these steps are rearranged, which is the correct order of steps? 

Activity 1:  Answer the following questions. 
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a.  i, ii,iii,iv b.  iv, iii.ii,I c. iii, ii, iv, I d. iii, iv, ii,i 

2. True or False. Write True if the statement is correct and False if it is incorrect. 

a. You can then use the Multilevel List command to choose the types of 
bullets or numbering that are used.  __________ 

b. To remove numbers or bullets from a list, select the list and click the 
Define New Bullet command. __________ 

c. Holding the Shift and press Tab will decrease the level.    __________ 

3. State in your own words the importance of formatting a list. 

a. _________________________________________________________

_________________________________________________________ 

b. _________________________________________________________

_________________________________________________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 

Summary 
You have come to the end of Lesson 18. In this lesson you have 
learned how to format a list by changing the bullet colour, creating a 
multilevel list and changing the level of a list. 

 

 
 
 

 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 18 ON THE NEXT PAGE. 
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Practice Exercise  18 
 

A. Follow the given instructions below. 
1. From the given texts below, use a computer, open document and make a list  

using bullets.  

Ana 

Marie 

Constantino 

Paul 

Emmanuel 

Alexandria 

Pedro 

2. Change the bullet colour by following the steps below. 

a. Click the Bullets drop-down arrow. 

b. Select Define New Bullet from the list. The Define New Bullet dialog box 
appears. 

c. Click the Font button. The Font dialog box appears. 

d. Click the Font Color drop-down box. 

e. Click on the desired colour to select it. 

f. Click OK.  

3. Using the list you have created, copy and paste to create another set of text. 

4. Create a multi level list by adding a description below each name. Use the 
descriptions below for each name. 

Ana – Tall and blond 

Marie- Short and brunette 

Constantino- Muscular and strong 

Paul- Skinny and pale 

Emmanuel- Funny and friendly 

Alexandria- Smart and religious 

Pedro- Naughty and rough 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 
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Answers To Activity 1 
1. c 

2. 

 a.  True 

 b.  False 

 c.  True 

3.   

a.  Formatting would enable you to enhance appearance of the list you 
have created.  

b.  It will also create the order of appearance of the items in the list 
according to your purpose. 
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Answers to Practice Exercises in Topic 3 
 
Practice Exercise 13 
Rubric to assess students’ work for Practice Exercise 13. 
Table 1 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Selected the Insert Tab on the ribbon.  
2) Located the Table icon on the ribbon and clicked on it.  
3) Dragged through the grid until it shows 5 x 4 table.   

4) Released the mouse and a table, 5 columns wide and 4 
rows high is created. 

 

Total  
 
Table 2 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Clicked below the table so a second table is created.  
2) Pressed [Enter] to make sure there is at least one blank 

paragraph before the second table is created. 
 

3) From the Insert tab on the ribbon clicked the Table icon 
again. 

 

4) Release your mouse and a table, 5 columns wide and 4 
rows high will be created. 

 

5) Selected to display the Insert Table dialog.   

6) Entered 3 for the number of columns and 2 for the number 
of rows.  

 

7) Clicked OK to create the table.   

Total  
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Table 3 

Categories 
for marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task component 
not done 

 

Task component 
partially 

completed 
 

Task component 
done confidently, 

and properly 

Tasks to perform  
1) Clicked the Table icon again.  
2) From the menu selected the .  
3) With the Draw Table icon selected, drawn a rectangle shape under 

the second table.  
 

4) Dragged a line down the middle of the table to divide it in to two 
columns.  

 

5) Dragged a horizontal line across the table to split it in to two rows.  

6) Continued to add lines until the table looks similar to the one 

below. 

 

Total  
 
The following steps were done to perform the task. 
Table 1 
1. Select the Insert tab on the ribbon.  

 

2. Locate the Table icon on the ribbon and click on it.  A grid of squares 
appears. This allows you to choose how many rows and columns your table 
will have.  

3. Drag through the grid until it shows 5 x 4 table like the example below.  
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4. Release your mouse and a table, 5 columns wide and 4 rows high will be 

created like the one below.  

 
Table 2 
1. Click below the table so we can create a second table (if MS Word will not let 

you click below the table because there are no more paragraphs under it, try 
double-clicking. You can double click on any place in a document to place the 
insertion point there).  

2. Press Enter to make sure there is at least one blank paragraph before you 
create the second table. Otherwise MS Word may join the two tables together 
– not a huge problem normally but for now we want separate tables.  

3. From the Insert tab on the ribbon click the Table icon again.  
4. This time when the menu appears, select to display the Insert Table 

dialogue box.  
5. Enter 3 for the number of columns and 2 for the number of rows.  

 
6. Click OK to create the table. It should look like the one below.  

 
 
Table 3 
1. From the Insert tab on the ribbon click the Table icon again.  
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2. From the menu select . When it is selected, your mouse pointer 

will turn in to a pencil shape.  
3. With the Draw Table icon selected, draw a rectangle shape under the second 

table as shown.  

 
4. When you have created the rectangle outline for the table, drag a line down 

the middle of the table to divide it in to two columns.  

 
5. Now drag a horizontal line across the table to split it in to two rows.  
6. Continue to add lines until the table looks similar to the one below. You can 

use undo if you make any mistakes.  

 
 

Practice Exericise 14 
Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

(3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform 
1. Create a 3x2 table  
2.  Data is encoded inside the table.  
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3. The Row height is set.  

4. The Column width is set.  

Total  
 
Your work should look like the example below. 
Names of Respondents Billing Address Comments 

Maria Isabel Constantino 
Guevarra 

113 Southwoods Park Avenue 
Calamba Laguna 

Respondent is living 
with her three sons 
and five daughters 

Corazon Marciana 
Ilumminada Concepcion 

945 Mc Arthur Driveway 
International Paete Laguna 

Respondent does not 
have any sons or 
daughthers but lives 
with three nieces and 
two nephews 

 
Perform the following steps to create these exercise. 
1. Open Table Properties Exercise. 
2. Create a table with 3 columns and 3 rows and type the given data. 
3. Click the Table Select icon to select the entire table. 
4. Select Table Properties. The Table Properties dialogue box will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
5. Adjust the Column and Rows properties. Your screen should look like the 

example below. 

4 

3 
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Practice Exericise 15 
Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

(3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform 
1) Selected the entire table.  
2) From the Table Tools Design tab chose Borders and Shading.   

3) Clicked the arrow next to the Borders icon to show the 
Borders menu. 

 

4) From the bottom of the menu selected the Borders and 
Shading option. 

 

5) Chose the same options as below. i.e. setting should be 
changed to Grid. Width should be changed to 4 ½ pt. and 
Color should be Automatic. 

 

6) Clicked OK when these options are selected.   

7) Using the output table from the first exercise, selected the first 
row of the table.  

 

8) Held down [Ctrl] and select the cells in the first column so that 
they are also selected.  
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9) Located the Shading Color icon on the Table Tools Design 
tab.  

 

10)  Clicked the arrow next to the icon so that a selection of 
colours appears. 

 

11) Clicked on a light colour to set that colour as the background 
for the cells.  

 

Total  
 
The following steps were done to create the exercise. 

A. Applying Borders and Shading.  

1. Click the arrow next to the Borders icon to show the Borders menu. 

 

2. From the bottom of the menu select the Borders and Shading option. 

 

3. Choose the same options as below. i.e. Setting should be changed to 
Grid. Width should be changed to 4 ½ pt. and Color should be 
Automatic. 

 
 
 
 
 
 
 
 

4. Click OK when these options are selected 

B. Adding Shades 
1. Using the output table from the first exercise above, select the first row of the 

table.  

2. Hold down [Ctrl] and select the cells in the first column so that they are also 
selected.  

3. Locate the Shading Color icon on the Table Tools Design tab.  

4. Click the arrow next to the icon so that a selection of colours appears. You can 
see a wider range of colours by clicking the More Fill Colors option at the 
bottom.  
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5. Click on a light colour to set that colour as the background for the cells.  
6. Your work may or may not look like the example below. 

   

   

   

  

   

  

   

  

   

   

   

   

 

Practice Exericise 16 
Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

(3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform 
1.  Total for each row were displayed using  AutoSum  
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2. The Student column were sorted in Ascending order.  

3. The Total column were sorted in Descending order.  

Total  
 
Your work should look like the example below. 
Auto Sum 
Student Year Mark Exam Total 

Jenny 43 38 81 

Gweneth 36 37 73 

Thalia 40 40 80 

Joe 29 45 74 

Felix 47 39 86 

Adam 25 36 61 

Average 36.67 39.17 75.83 

 
Sorting 
Student column in Ascending order 

Student Year Mark Exam Total 

Adam 25 36 61 

Felix 47 39 86 

Gweneth 36 37 73 

Jenny 43 38 81 

Joe 29 45 74 

Thalia 40 40 80 

 

Total column in Descending order 
Student Year Mark Exam Total 

Felix 47 39 86 

Jenny 43 38 81 

Thalia 40 40 80 

Average 36.67 39.17 75.83 

Joe 29 45 74 

Gweneth 36 37 73 

Adam 25 36 61 
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Practice Exercise 17 
Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

(3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform 
1. Apply bullets to text.  

2. Apply numbers to text.  

Total  
 
Your work should look like the example below. 
A. 

 
B. 
Bulleted and numbered lists can be used in your documents to format, arrange and 
emphasize text. 
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Practice Exercise 18 
Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

(3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform 
1. Apply Bullets to texts.  

2. Change the colour of the bullets.  

3. Copy and paste text.  

4. Apply Multi-level list to text  

Total  
 
Your work should look like the example below. 

 
 

End of Topic 3 
 

Now Do Exercise 3 in Assignment Book 2 Then Go to Topic 4. 
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TOPIC 4 
 
 
 
 
 

UNIT 2 
 
 
 
 
 

DRAWING, CHARTS AND PICTURES 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson 19: Using Drawing Tools  
Lesson 20: Using the Equation Editor 
Lesson 21: Inserting Charts  
Lesson 22: Using Clip Art 
Lesson 23: Inserting Picture from a File 
Lesson 24: Formatting Pictures from a File 
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TOPIC 4: DRAWING, CHARTS AND PICTURES 

 

In this topic you will learn about using drawing, charts and pictures to your 
documents. The Topic is designed to familiarise you with how to efficiently use 
drawing, charts and pictures.  

This topic, has six (6) lessons: 

Lesson 19  focuses on defining, drawing tools, identify the uses of drawing tools in 
a documentand determining the importance of using drawing tools in 
the document. 

Lesson 20  defines, identifies the steps and the importance of using the Equation 
Editor in a the document. 

Lesson 21 defines and identifies different chart type, the steps and the importance 
of inserting charts in a document.. 

Lesson 22 defines and identifies clip arts and the steps of inserting them. 

Lesson 23  discusses how to insert a picure from a file and the importance of 
inserting it in a document. 

Lesson 24 explains the steps in inserting a picture from a file and its importance in 
the document. 

By the end of Topic 4, you should be able to use more advanced word processing 
skills and techniques, create quality word processed documents and demonstrate 
knowledge and skills on the efficient use of word processing procedures. 
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Lesson 19: Using Drawing Tools 
 

 
 
 
 
 
 
 
 
 
 
Drawing Tools 
Drawing Tools are tools which include AutoShapes, lines, and other options that 
make it easy to draw, color, or position presentation objects.The Drawing tools are 
accessed quite differently in Microsoft Office 2010 than in earlier versions of 
Microsoft’s Office software. There is also a significantly larger set of tools for you to 
use and they are organized according to the type of drawing work you are doing.  
There are many ways on how the Drawing Tools are important in Miscrosoft Word. 
First, if you are working with Shapes of all kinds you can use the Shapes Tool in the 
Insert Ribbon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Welcome to Lesson 19 of Unit 2. In Lesson 18, you have learned 
how to format the list you have created using bullets and 
numbering . In this lesson you shall learn how to use drawing 
tools in your document.  
 

Your Aims: 
 define drawing tools 
 identify the different uses of drawing tools in a 

document 
 determine the importance of using drawing 

tools 

1 

2 

3 
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Next, if you are working with a picture, such as a photograph, when the picture is 
selected by clicking on it (when it has the handles around it), then Microsoft Word 
presents a wide selection of Picture Tools in the Format Ribbon. Inserting and 
manipulating Pictures and Clip Arts will be discussed further in Lesson 22 of this 
Topic. Now, try inserting a picture or a photograph then click on it and observe the 
handles as shown in the picture below. 
 
 

 
Also, there is a large selection of Clip Art you can use in your documents. You can go 
to the Insert Ribbon  Clip Art  to access the clip art task pane. 

 

 
Then, there is a tool, in the Insert Ribbon that is used for creating what is called 
Smart Art.  

Notice the handles around 
the picture which appear 
when you click on it to 
select it. This automatically 
brings up the Picture Tools 
Format Ribbon. 

Picture Tools 

Clip Art Gallery 
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The Smart Art Diagram Gallery contains a selection of diagrams which makes it easy 
to create graphical Lists, Process and Cycle diagrams, Hierarchy charts, Relationship 
diagrams, graphical matrices, and Pyramid charts.  

Lastly, another useful drawing tool is called WordArt, which makes it easy for you to 
insert decorative text into your document. Word Art was discussed in Lesson 9 of 
Topic 2. 

The Drawing Tools in Office 2010 
In this section, you will learn how to use the basic drawing tools to work with simple 
shapes and lines.  

The figure below illustrates the Drawing Tools Format Ribbon. To see this ribbon you 
need to have a drawing object or shape on the page. 

 

In the Insert Ribbon, click in the Insert Menu then click Shapes Tool to bring down 
the palette or menu of pre-defined shapes. 

 

WordArt Styles 
Group in the 
Drawing Tools 
Format Ribbon 

Smart Art 
Dialogue 
box 
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As you can see, there are dozens of shapes to choose from, including lines, 
rectangles, other basic geometric shapes, brackets, and so forth, block arrows, 
flowchart shapes, stars and banners, and even callouts, which you will practice using 
later in this lesson. 

Now, let us start practicing how to insert and format a drawing object using the 
drawing tools. 

1. In the Shapes menu, click on the Rectangle shape.  

2. Then hold down the left button of the mouse and drag on the page to draw a 
simple rectangle With the rectangle selected (it has the handles around it). In 
the Drawing Tools Format Ribbon, take a look at the many tools for working 
with drawing objects. 

 

Rectangle Shape 
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3. In the Format Ribbon  Shape Styles Group. 

4. Click on the small arrow next to the Shape Fill tool and slide the mouse 
pointer over any color, gradient, or texture you like from the Theme Colors 
menu to try them out and see how they look before you actually select one of 
them for your shape.  

5. When you have made up your mind, click on your selection of a colour, 
gradient, or texture for your rectangle to implement the change in the object on 
your screen. If you do not have further use for this rectangle shape just now, 
hit the Backspace or Delete key to remove it from the page.  

After using a rectangle, let us start with drawing lines or arrows. 

1. In the Format Ribbon  Insert Shapes Group, click on the straight line or 
arrow tool to select it. Use the mouse to draw a straight line object or an arrow 
anywhere on the page. 

Next, we can now try working more with lines and arrows. Follow the steps below on 
how to draw different styles of lines and arrows. 

2. Using the line or arrow drawn in Step 1, click anywhere off the line and notice 
that the handles (little circles) at each end of the line disappear.  

You can only edit or move a drawing object such as a line, an arrow 
or rectangle if the handles are showing. The handles indicate that 
the object is selected. Clicking ON the object selects it; clicking OFF 
the object deselects it. 

 

 

 

 

 

 

 

 

3. Position the mouse pointer anywhere on the line and notice how the cursor 
changes to a crosshair ( ). The crosshair which tells you that the mouse is 
correctly positioned on the line so that when you click the mouse it will select 
it.  

 

 

 

Click on the shape, line or arrow then slide the mouse pointer 
over it and notice that the pointer changes to a crosshair ( ) any 
time the pointer is anywhere within the perimeter of the shape- the 
crosshair tells you that you can move or edit the shape. 

The Handles indicating that an object is selected. 
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4. Click anywhere on the line now, and notice that the handles (little circles) at 

each end reappear. Now, with the handles showing, you can edit the line. 

 

 

 

 

 

 

 

 

5. In the Format Ribbon  Shape Styles Group 

6. If for some reason you do not see the Shape Styles Group, click on the 
Format Tab to show the Format Ribbon, click on the small arrow next to the 
Shape Outline tool to show the pop up menu of line colours and styles. 

7. When you are done checking out all the different design options for the line, hit 
the Backspace key or the Del key to delete it from the page. 

Now, let us draw and edit ovals. Follow the steps below on how to create and edit 
ovals. 
1. In the Insert Ribbon, click on Shapes to bring down the palette of shapes, 

then click on the oval tool to select it, and use the mouse to draw an oval on 
the page. 

 

2. Notice the handles that surround the oval shape, four in the corners and four 
at the middle of each side and the small green circle at the top. You use these 

The small green circle handle can be used to rotate any 
drawing object while the small white handles can be used to 
stretch or resize the shape of any drawing object. 

 
 

Oval shape 
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handles to change the shape of the object. Try this now by grabbing any of the 
small white handles and stretching them one way and another to change the 
shape of the oval. 

 

 

 

 

 

 

 

3. Notice the ninth handle outside the selected oval—a small green circle. This 
small green handle enables you to rotate the shape very precisely either 
clockwise or counter-clockwise. Use the mouse to point at the small green 
handle (the rotate object handle) and drag from left to right in a circular motion 
to rotate the oval object. 

 
4. While you have the oval selected, use the tools in the Shape Styles Group to 

change the Fill to any colour, texture, or gradient you want. You can also 
change the border of the shape to 6 pt. line, and change the border color to 
any colour you want. 

 
 
  

5. When you are done editing the oval shape, hit the Backspace key or the Del 
key to delete it from the page. 

 

 

Small white handles are 
used to stretch or change 
the shape of any drawing 
object. 

Shape Outline displaying different options. 



GR10 D&T – COMPUTING U2          198  TOPIC 4 LESSON 19  
  

 
 
 

1. List the uses or importance of Drawing Tools in a MS Word document. 
 

a.  

___________________________________________________________

___________________________________________________________ 

b.  

___________________________________________________________

___________________________________________________________ 

c.  

___________________________________________________________

___________________________________________________________ 

 

d.  

___________________________________________________________

___________________________________________________________ 

2. What menu from the Ribbon bar is used when you want to use Shapes? 

___________________________________________________________ 

3. What menu will you use if you want to change the shape, fill or outline of a 
shape? 

___________________________________________________________ 

4. What are the functions of the following? 

a. Crosshair 

___________________________________________________________

___________________________________________________________ 

b. Small green handle 

___________________________________________________________

___________________________________________________________ 

c. Small white handles 

___________________________________________________________

___________________________________________________________ 

Activity 1:  Answer the following questions. 
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Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

 

 
Summary 
You have come to the end of Lesson 19. In this lesson you have 
defined, used and learned the importance of using drawing tools in 
your document.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICAL EXERCISE 19 ON THE NEXT PAGE. 
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Practical Exercise  19 

 

Follow the instructions to create and edit shapes using the Drawing Tools. 
 

Shape 1 

1. Select the Insert tab on the ribbon.  

 

2. Locate the Shapes icon  on            the ribbon and click on it.  

3.  Choose and click on Regular Pentagon under the Basic Shapes. 

4. Drag and position the shape in the center of the document.  

5. Change the shape style to Colored Fill, White Outline - Accent 6 and shape 
outline weight to 6pt.  

 
Shape 2 
1. Select the Insert tab on the ribbon.  

 

2. Locate the Shapes icon   on  the ribbon and click on it.  

3.  Choose and click on Isosceles Triangle under the Basic Shapes. 

4. Drag and position the shape into the document.  
5. Enlarge the shape. 
6. Rotate the shape so it will become an up side down isosceles triangle. 
7. Change the shape fill to texture-Water Droplets and shape outline weight to    

4 1/2 pt.  

 
Shape 3 
1. Select the Insert tab on the ribbon.  

 

2. Locate the Shapes icon    on the ribbon and click on it.  

3.  Choose and click on Arrow under Lines. 

4. Drag and position the shape into the document.  
5. Repeat steps 3-4 twice. 
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6. Move the three arrows in such a way that their arrow heads intersect in the 

middle. 
7. Change the shape outline weight to 3pt, 6pt and 21/2 pt respectively.  

 

 
 
 
 
Answers to Activity 1 
1.  

a. If you are working with Shapes of all kinds you can use the Shapes tool 
in the of the Insert Ribbon. 

b. If you are working with a picture, such as a photograph, when the picture 
is selected by clicking on it (when it has the handles around it), then 
Microsoft Word presents a wide selection of Picture tools in the Format 
Ribbon. 

c. There is a large selection of Clip Art you can use in your documents. You 
can go to the Insert Ribbon  Clip Art  to access the clip art task pane. 

d. You can also use the Smart Art or the Word Art tool 
 
2. Insert Tab 

3. Format Menu 

4. Crosshair- the crosshair tells you that you can move or edit the shape. 

Small green handle- The small green circle handle can be used to rotate any 
drawing object. 

Small white handles- The small white handles can be used to stretch or resize 
the shape of any drawing object. 

 

 
 
 

 
 
 
 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 4.  
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Lesson 20: Using the Equation Editor 
 
 
 
 
 
 
 
 
 
 

The Equation Editor 
Equation Editor is a special version of the Math Type equation editor from Design 
Science that is customized for use with Microsoft applications. 
Equation Editor allows you to enter an algebraic equation of standard mathematical 
operators and functions. Once a valid equation is entered and enabled, the display of 
the active trace is replaced with the results of the equation, and updated in real-time 
as new data is acquired.  For equations that can be expressed with Equation Editor's 
supported functions, operators, and data, there is no need for off-line processing in a 
separate program. 
Microsoft Word 2010 includes built-in support for writing and changing equations. As 
a result, Equation Editor is not used, but instead equations are edited directly from 
within Word. The next sub topics will enable you to use equations in Microsoft Word 
2010. 

Write an Equation 
To write an equation, you can use Unicode character codes and Math AutoCorrect 
entries to replace text with symbols. Unicode is a character encoding standard that 
has widespread acceptance. Unicode provides a unique number for every character 
and so you do not have this problem if you use Unicode. If your document calls for 
U+0289  it will be clear to any computer program what the character should be. 
 
When you type an equation, Word automatically converts the equation into a 
professionally formatted equation. Follow the steps below to write an Equation.  

1. On the Insert tab, in the Symbols group, click the arrow next to Equation.  

 

2. Click the equation that you want, or click Insert New Equation to type an 
equation. 

Welcome to Lesson 20 of Unit 2. In Lesson 19, you have learned 
the definition, use and importance of drawing tools in your 
document. In this lesson you shall learn how to use the Equation 
Editor. 
 Your Aims: 

 define Equation Editor 
 perform the steps on using the Equation Editor 
 determine the importance of using the Equation 

Editor 
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Now after locating the equations, let us add an Equation to the List of 
Frequently Used Equations. Follow the steps below on how to add an 
equation to the list of frequently used equations. 

 
3. In the document, select the equation that you want to add. 

4. Under Insert tab, click Equation, and then click Save Selection to Equation 
Gallery. 

 

5. In the Create New Building Block dialog box, type a name for the equation. 

6. In the Gallery list, click Equations. 

7. Select any other options that you want. Then Click OK. 

 

Built-in Equations 

1 

2 

4 
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Insert a Commonly Used Math Structure 
Follow the steps below on how to insert a commonly used Math structure. 

1. On the Insert tab, in the Symbols group, click the arrow next to Equation, and 
then click the equation that you want.  

 

2. Under Equation Tools, on the Design tab, in the Structures group, click the 
structure type that you want, such as a fraction or a radical, and then click it. 

Built-in Equations 

6 

7 
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3. If the structure contains placeholders, click in the placeholders and type the 
numbers or symbols that you want. Equation placeholders are small, dotted 
boxes in an equation. 

 

 

4. Repeat the process until you become comfortable doing it. 

 
Change an Equation that was Written in a Previous Version of Word 
To change an equation that was written in a version of Word prior to Word 2007, you 
must use the Equation 3.0 add-in or the Math Type add-in that was used to write the 
equation. 

When you open a document that contains an equation that was written in a previous 
version of MS Word, you cannot use the built-in support for writing and changing 
equations. 

 

 
 
 

1. Explain the importance of an Equation editor in a MS Word document. 
______________________________________________________________

______________________________________________________________ 

______________________________________________________________ 

2. In Microsoft 2010, why is Equation Editor not used?  

___________________________________________________________ 

Activity 1:  Answer the following questions. 

2 

An enlarge image of the Equation placeholders. 
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3. What tab will you use if you want to write an equation? 

___________________________________________________________ 

4. Explain the steps on how to write an equation. 

a. ___________________________________________________________ 

___________________________________________________________ 

b. ___________________________________________________________ 

___________________________________________________________ 

c. ___________________________________________________________ 

___________________________________________________________ 

d. ___________________________________________________________ 

___________________________________________________________ 

e. ___________________________________________________________ 

___________________________________________________________ 

f. ___________________________________________________________ 

___________________________________________________________ 

g. ___________________________________________________________ 

___________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

 
Summary 
You have come to the end of Lesson 20. In this lesson you have 
defined, used and learned the importance of using the Equation Editor 
to your document. 
  

 

 
 NOW DO PRACTICAL EXERCISE 20 ON THE NEXT PAGE. 
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Practical Exercise  20 

 

Follow the instructions on how to write and add an equation using the 
Microsoft 2010 Equation. 
 
1. Open a blank document. 

 
2. Insert the equation for Area of a Circle. Change the values of r to 20. 

 
3. Following the steps from the previous lesson, add this equation  x2 – 4 = 0 

to the list of frequently used equations. Get screenshots for every step you 
have done. 

 

 
 
 

Answers to Activity 1 
1. Equation Editor allows you to enter an algebraic equation of standard 

mathematical operators and functions. Once a valid equation is entered and 
enabled, the display of the active trace is replaced with the results of the 
equation, and updated in real-time as new data is acquired.  For equations 
that can be expressed with Equation Editor's supported functions, operators, 
and data, there is no need for off-line processing in a separate program. 

2. Microsoft Word 2010 includes built-in support for writing and changing 
equations. As a result, Equation Editor is not used. 

3. Insert Tab 
4.  

a. On the Insert tab, in the Symbols group, click the arrow next to Equation.  

b. Click the equation that you want, or click Insert New Equation to type an 
equation. 

c. In the document, select the equation that you want to add. 

d. Under Insert tab, click Equation, and then click Save Selection to 
Equation Gallery. 

e. In the Create New Building Block dialog box, type a name for the 
equation. 

f. In the Gallery list, click Equations. 

g. Select any other options that you want. Then Click OK. 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.  
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Lesson 21: Inserting Charts 

 

 
 
 
 
 
 
 
 

 

Charts 
A chart is a sheet presenting information in the form of graphs or tables. Charts are 
important as these are pictorial representations of data that relay important 
information to the user of the document. These are also called as presentation 
graphics. 
In Microsoft Word 2010, you can insert many kinds of data charts and graphs, such 
as column charts, line graphs, pie charts, bar charts, area graphs, scatter graphs, 
stock charts, surface charts, doughnut charts, bubble graphs, and radar graphs. 
Charts can be used in MS Word to create and perform any of the following: 

• bar chart or column chart.  

• line or XY scatter (data point) chart.  

• stock chart, used to graph various stock prices.  

• surface, donut, bubble, or radar chart.  

• Link to live data in a Microsoft Excel workbook.  

• Update your chart automatically when numbers in a Microsoft Excel workbook 
are updated.  

• Use "what-if" calculations, and enables you to change numbers and see the 
changes automatically and immediately as reflected in the chart.  

• Automatically add legends or gridlines that are based on your data.  

• Use chart-specific functionality, such as error bars or data labels.  

The following are the different types of charts available in Microsoft Word 2010. 

 Column chart - A type of presentation graphic in which numerical values are 
illustrated with horizontal columns. Column graphs are particularly effective for 

Welcome to Lesson 21 of Unit 2. In Lesson 20, you have 
learned about the definition of Equation Editor, its use and 
importance in the document. 
In this lesson, you will learn about charts. 
 

Your Aims: 
 define charts 
 identify different chart types 
 perform the steps on inserting charts 
 determine the importance of inserting charts 



GR10 D&T – COMPUTING U2          209  TOPIC 4 LESSON 21  
  

showing values that are categorized by two separate characteristics, such as 
year and sector. 

 Line Chart - A type of graph that highlights trends by drawing connecting lines 
between data points. 

 Pie Chart - A type of presentation graphic in which percentage values are 
represented as proportionally-sized slices of a pie. 

 Bar Chart - A type of graph in which different values are represented by 
rectangular bars. 

 Area Chart - A type of presentation graphic that emphasizes a change in 
values by filling in the portion of the graph beneath the line connecting various 
data points. 

 X Y Chart - XY (scatter) charts show the relationship between the numeric 
values in several series of data. 

 Surface Chart -  A chart which enables you to find combinations between two 
sets of data when both the categories and values are numeric. 

 Doughnut Chart - Doughnut charts show the proportions of parts to a whole 
and can show more than one series of data. 

 Bubble Chart - A bubble chart is a type of chart that displays three 
dimensions of data. Bubble charts can facilitate the understanding of social, 
economical, medical, and other scientific relationships. 

 Radar Chart - A radar chart is a graphical method of displaying multivariate 
data in the form of a two-dimensional chart of three or more quantitative 
variables represented on axes starting from the same point. 

 
Inserting Charts 
Follow the steps on how to insert charts in a document. 
 

1. On the Insert tab, in the Illustrations group, click Chart.  

 

2. In the Insert Chart dialogue box, click the arrows to scroll through the chart 
types. The first box shows a list of chart type categories, and the second box 
shows the available chart types for each chart type category.  

1 
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3. Select the type of chart that you want and then click OK.  

  

 

Formatting Charts 
Formatting the charts will change its appearance as designs, layouts and formats are 
added unto it.  

To get a good idea of what you can add to or change in your chart, do the following 
steps. 

1. Under Chart Tools, click the Design, Layout, and Format tabs, and then 
explore the groups and options that are provided on each tab.  

 

 

When you rest the mouse pointer over any chart type, a ScreenTip displays its 
name. 

Screen Tip 

The Design tab under the Chart Tools group displaying different chart styles. 
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If you do not see the Chart Tools, make sure that you click anywhere inside the chart 
to activate it.  

You can also access design, layout, and formatting features that are available for 
specific chart elements (such as chart axes or the legend) by right-clicking those chart 
elements.  

The Layout tab in Chart Tools group displaying different chart layout. 

The Format tab in the Chart Tools group displaying different word formats. 
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Changing the Look of Charts  
For most 2-D charts, you can change the chart type of the whole chart to give the 
chart a different look, or you can select a different chart type for any single data 
series, which turns the chart into a combination chart.  
 

Follow the steps below on how to change the look of charts. 

1. Open a blank document. 

2. Insert a chart. For this purpose, choose a Column chart. Enter the same 
information as shown by the chart below. 

 

 

3. To change the chart type of the whole chart, click the chart area or the plot 
area of the chart to display the Chart Tools.  

 

 

 

4. On the Design tab, in the Type group, click Change Chart Type.  

 

You can also right-click the chart area or plot area, click Change Chart Type, 
and then continue with step 4.  

 

An example of column chart. 
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5. In the Change Chart Type dialog box, click a chart type that you want to use. 
For this purpose, choose Line Chart. 

 

6. Then click OK. 

7. Repeat the process until you become comfortable doing it. 
 

 
 
 

1. Explain the importance of charts in a Word document. 
 

______________________________________________________________

______________________________________________________________ 

 

Activity 1:  Answer the following questions. 

4 
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2. Name all the types of charts 

______________________________________________________________

______________________________________________________________ 

3. What are the three tabs you can find under Chart Tools? 

___________________________________________________________ 

4. What are the steps on how to change the look of your chart? 

a. _________________________________________________________ 

b. _________________________________________________________ 

c. _________________________________________________________ 

d. _________________________________________________________ 

e. _________________________________________________________ 

5. List the steps on how to insert then format a chart. 

a. __________________________________________________________

_________________________________________________________ 

b. __________________________________________________________

_________________________________________________________ 

c. __________________________________________________________

_________________________________________________________ 

d. __________________________________________________________

__________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

Summary 
You have come to the end of Lesson 21. In this lesson you have 
defined, learned the types, use and importance of charts to your 
document.  

 

 
 

 

NOW DO PRACTICAL EXERCISE 21 ON THE NEXT PAGE. 
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Practical Exercise  21 

 

Follow the given instructions on how to insert and format a chart. 
1. Open a blank document. 

2.  Go to Insert Menu and click on Charts. 

3. Choose Bar Chart (Clustered Bar). Click OK. 

4. Enter the data below. Categories are Bart, Claudia, Henry and Poly while 
Mathematics, Science and English are the Series. 

 

5. Click on the inserted chart and this will lead you to the Chart Tools.  

6. Under the Chart Tools, click on Design and choose Chart Style 46. 

7. Repeat Step 6. Click on Layout. 

8. Under Layout, select Chart Title (Above Chart) and write Term 1 Marks as the 
chart title. 

9. Repeat Step 6. Click on Format. 

10. Under Format, select Shape Style and choose Colored Outline – Aqua, Accent 
5. 

11. Repeat Step 6. Click on Design. 

12. Under Design, select Change Chart Type. 

13. Select Line (Stacked Line) and click OK. 

 

 
 
 
 
 
 
 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.  
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Answers to Activity 1 

1. A chart is a sheet presenting information in the form of graphs or tables. 
Charts are important as these are pictorial representations of data that relay 
important information to the user of the document. Border button 

2. Column chart, Line Chart, Pie Chart, Bar Chart, Area Chart, X Y Chart, 
Surface Chart, Doughnut Chart, Bubble Chart, Radar Chart. 

3. Design tab, Layout tab and Format tab. 

4.  

a. Open a blank document. 

b. Insert a chart. 

c. To change the chart type of the whole chart, click the chart area or the 
plot area of the chart to display the Chart Tools. 

d. On the Design tab, in the Type group, click Change Chart Type.  

e. In the Change Chart Type dialog box, click a chart type that you want to 
use. 

5.  

a. On the Insert tab, in the Illustrations group, click Chart.  

b. In the Insert Chart dialog box, click the arrows to scroll through the chart 
types.  

c. Select the type of chart that you want and then click OK.  

d. Under Chart Tools, click the Design, Layout, and Format tabs, and then 
explore the groups and options that are provided on each tab.  
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Lesson 22: Inserting Clip Arts and Pictures 
 
 
 

 
 
 
 
 
 

 

Clip Arts  
Clip Arts are electronic illustrations that can be inserted into a document. It is a 
collection of pictures or images that can be imported into a document or another 
program.  
Many clip-art packages are available, some general and others specialized for a 
particular field. Clip Arts are important as images are a great way to liven up a 
document, and Word offers a couple of ways of inserting images.  
There are built-in Clip Art images for just about every topic, so you may be able to 
find a perfect Clip Art image for your document.  

Locating Clip Art  
Follow the steps below on how to locate a Clip Art. 

1. Open a blank word document. 

2. Select the Insert tab. 

3. Click the Clip Art command in the Illustrations group. 

 

3. The Clip Art options appear in the task pane to the right of the document. 

Welcome to Lesson 22 of Unit 2. In Lesson 21, you have 
learned the definition, types, use and importance of charts in 
the document. In this lesson you will learn how to insert Clip 
Arts. 

Your Aims: 
 define clip arts  

 perform the steps on inserting clip arts  

 determine the importance of using clip arts  

2 

3 
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4. Enter keywords in the Search for: field that are related to the image you wish 
to insert. For example, type the word ―ball‖ in the Search for field. 

5. Click the drop-down arrow in the Results should be: field. 

 
 
 
 
 
 

Search for: field 

Drop-down arrow in the 
Results should be: field 

If you would like to also search for Clip Art on Office.com, click Include 
Office.com content. Otherwise, it will just search for Clip Art on your 
computer. 

 

4 

The Clip Art Gallery 
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Inserting Clip Art       
After you have located the ClipArt, you will now insert a ClipArt to your document. 
Follow the following steps. 
1. Place your insertion point in the document where you wish to insert the clip 

art.  

2. Click Insert menu and select Clip Art.  

 

3. The Clip Art options appear in the task pane to the right of the document. 

4. Enter keywords in the Search for: field that are related to the image you wish 
to insert. 

5. Review the results from a clip art search. 

6. Click an image in the Clip Art pane. It will appear in the document. 
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1. Explain the importance of using Clip Art  in a Word document. 

 
______________________________________________________________

______________________________________________________________ 

 

2. What menu are you going to select when looking for Clip Art? 

______________________________________________________________

______________________________________________________________ 

3. List the steps when searching for a clip art. 

a. _________________________________________________________ 

b. _________________________________________________________ 

c. _________________________________________________________ 

d. _________________________________________________________ 

e. _________________________________________________________ 

4. List the steps when inserting a clip art 

a. __________________________________________________________ 

b. __________________________________________________________ 

c. __________________________________________________________ 

d. __________________________________________________________ 

Activity 1:  Do the following. 
 

Select and change the text wrap of the inserted clip art and it can be resized and 
rotated already by using the small green handle to rotate and the small white 
handles to resize. 

 

The small green handle is on 
top and the small white 
handles on the corners and 
sides of the clip art. 
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e. ___________________________________________________________ 

f. ___________________________________________________________ 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 

Summary 
You have come to the end of Lesson 22. In this lesson you have 
defined, used and learned the importance of using Clip Art and 
Pictures to your document. 
 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICAL EXERCISE 22 ON THE NEXT PAGE. 
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Practical Exercise 22 
 

Follow the given instructions below on how to search and insert a clip art. 

1. Open a blank document. 

2.  Click Insert menu and select Clip Art. 

3. Inside the Search for: field, type the keyword ―sports‖. 

4. Review the search results and select the clip art for ―athletes, baseball‖. 

5. Click the clip art and it will appear in your document. 

6. Rotate the clip art upside down and enlarge it by using the handles. 

  

 
 
 

 

Answers to Activity 

Activity 1 

1. Clip Arts are important as images are a great way to liven up a document 
2. Insert menu 

3.  

a. Select the Insert tab. 

b. Click the Clip Art command in the Illustrations group. 

c. The Clip Art options appear in the task pane to the right of the document. 

d. Enter keywords in the Search for: field that are related to the image you 
wish to insert. 

e. Click the drop-down arrow in the Results should be: field. 

4.  

a. Place your insertion point in the document where you wish to insert the 
clip art. 

b. Click Insert menu and select Clip Art.  

c. The Clip Art options appear in the task pane to the right of the 
document. 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4. 
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d. Enter keywords in the Search for: field that are related to the image you 
wish to insert. 

e. Review the results from a clip art search. 

f. Click an image in the Clip Art pane. It will appear in the document. 
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Lesson 23: Inserting Picture from a File 
 

 
 
 
 
 
 
 
 

Picture from a File 
In Grade 9 Design and Technology Unit 2 Lesson 22, you were taught how to create 
a resume and insert a picture from a file that you can use for the resume.  
Pictures used in Word are visual representations or images painted, drawn, 
photographed, or otherwise rendered on a flat surface which are in their electronic 
form. If you have a more specific image in mind, you can insert a picture from a file.  
Inserting a picture from a file is important as it enables you to locate and use as 
many pictures you need from different locations. This variety gives you choices to 
enhance your work better and capture the message you would want to relay to the 
reader of your document. Adding pictures to your document can be a great way to 
illustrate important information or add decorative. 

To Insert a Picture From a File 
Follow the steps below on how to insert picture from a file. 

1. Place your insertion point where you want the image to appear. 

2. Select the Insert tab.  

3. Click the Picture command in the Illustrations group. The Insert Picture 
dialogue box appears. 

 

4. In the Insert ribbon, click Picture. This will automatically go to the Pictures 
library. This is the place where photos are usually stored in your computer. If 
your photo is not saved here, you need to locate it using the picture dialogue 
box. 

Welcome to Lesson 23 of Unit 2. In Lesson 22, you have learned 
the definitions, use and importance of using Clip Art and Pictures. 
In this lesson, you will learn how to insert a picture from a file into 
the document. 

Your Aims: 
 perform the steps on inserting picture from a 

file 
 determine the importance of inserting picture 

from a file 

1 

2 
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5. The left side of your screen displays the different locations where your picture 
may be saved. Select the location of your picture. 

 

 

 

 

 

 

 

 

 

 

 

6. Select the desired image file and click Insert to add it to your document. 

7. Click Insert and the picture file will be inserted in your document. 

 

 
 
 
 
 

The CD drive or your flash drive may 
contain your photo. 

JPEG image means it is a 
photo file.  

To resize an image, click and drag one of the corner sizing handles. The 
image will change size while keeping the same proportions. If you want to 
stretch it horizontally or vertically, you can use the side sizing handles. 

The Insert Picture dialogue box. 
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Changing the Text Wrapping Settings 
When you insert Clip Art or a picture from a file, you may notice that it is difficult to 
move it exactly where you want it. That is because the text wrapping for that image 
is set to In Line with Text. Text wrap is a feature supported by many word 
processors that enables you to surround a picture or diagram with text. The text 
wraps around the graphic. 

You will need to change the text wrapping setting if you want to move the image 
freely, or if you just want the text to wrap around the image in a more natural way. 

To Wrap Text Around an Image 
Follow the steps below on how to wrap text around an image. 

1. Select the image. The Format tab will appear. 

2. Click the Format tab. 

3. Click the Wrap Text command in the Arrange group. 

4. Select the desired menu option. The text will adjust based on the option you 
have selected. 

 

5. Move the image around to see how the text wraps for each setting. 

 

 

 

 

 

 

2 

3 

http://www.webopedia.com/TERM/F/feature.html
http://www.webopedia.com/TERM/S/support.html
http://www.webopedia.com/TERM/W/word_processor.html
http://www.webopedia.com/TERM/W/word_processor.html
http://www.webopedia.com/TERM/T/text.html
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To Use a Pre-Defined Text Wrapping Setting 
Follow the steps below on how to use a pre-defined text wrapping setting. 

1. Click the Position command, to the left of the Wrap Text command. A drop-
down menu will appear. 

2. From the drop-down menu, select the desired image position.  

 

3. The image will move to the position that you have selected, and it will 
automatically have text wrapping applied to it. 

 

 
 
 

1. Explain the importance of Text Wrap in a Word document. 
 

______________________________________________________________

______________________________________________________________ 

Activity 1:  Answer the following. 
 

If you cannot get your text to wrap the way you wish, click the Wrap Text 
command and select More Layout Options from the menu. You can make more 
precise changes in the Advanced Layout dialog box that appears. 

 

 

1 

2 
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2. What tab are you going to select when looking for wrap a text around an 

image ? 

______________________________________________________________ 

3. Explain the steps on how to wrap a text around an image. 

a. __________________________________________________________ 

b. __________________________________________________________ 

c. __________________________________________________________ 

d. ___________________________________________________________ 

4. What command are you going to use if you want to position your image with 
text wrapping applied to it already? 

______________________________________________________________ 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

 

Summary 
You have come to the end of Lesson 23. In this lesson you have 
learned how to insert a picture from a file and its importance to your 
document.  

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICAL EXERCISE 23 ON THE NEXT PAGE. 
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Practical Exercise  23 
 

Follow the instructions below to insert picture from a file and apply wrap text 
on it . 

1. Open a new blank document.  

2. Type the this paragraph. 

Penguins (order Sphenisciformes, family Spheniscidae) are a group of 
aquatic, flightless birds living almost exclusively in the Southern Hemisphere, 
especially in Antarctica. Highly adapted for life in the water, penguins have 
countershaded dark and white plumage, and their wings have evolved into 
flippers. Most penguins feed on krill, fish, squid and other forms of sealife 
caught while swimming underwater. They spend about half of their lives on 
land and half in the oceans. 

3. From the Pictures Library, select the picture of the ―Penguins‖. Resize the 
image. 

4. Select the picture and from the Format tab, select Wrap Text. 

5. Choose ―Square‖ as the wrap text type for the inserted picture. 

6. Save your work as Penguin Wrap Text. 

 

 
 
Answers To Activity 
1. Inserting a picture from a file is important as it enables you to locate and use 

as many pictures you need from different locations. This variety gives you 
choices to enhance your work better and capture the message you would 
want to relay to the reader of your document. Adding pictures to your 
document can be a great way to illustrate important information or add 
decorative. 

2. Format tab 

3.  

a. Select the image. The Format tab will appear. 
b. Click the Format tab. 
c. Click the Wrap Text command in the Arrange group. 
d. Select the desired menu option. The text will adjust based on the option 

you have selected. 

4. Position command 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4. 

http://en.wikipedia.org/wiki/Order_(biology)
http://en.wikipedia.org/wiki/Family_(biology)
http://en.wikipedia.org/wiki/Aquatic_bird
http://en.wikipedia.org/wiki/Flightless_bird
http://en.wikipedia.org/wiki/Bird
http://en.wikipedia.org/wiki/Southern_Hemisphere
http://en.wikipedia.org/wiki/Antarctica
http://en.wikipedia.org/wiki/Countershading
http://en.wikipedia.org/wiki/Flipper_(anatomy)
http://en.wikipedia.org/wiki/Krill
http://en.wikipedia.org/wiki/Fish
http://en.wikipedia.org/wiki/Squid
http://en.wikipedia.org/wiki/Sealife
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Lesson 24: Formatting Pictures from a File 
 

 
 
 
 
 
 
 
 
 

Formatting Pictures from a File 
Once you have added pictures to your documents, you can format them in various 
ways. The picture tools in Word 2010 make it easy to incorporate images into your 
documents and modify those images in interesting ways.  

In this lesson, you will learn how to change the picture style and shape,add a border, 
crop and compress pictures, add artistic effects, and more. 

Formatting pictures makes it easier for readers to understand your pictures ang give 
your document a more interesting and professional presentation. It enables you to 
manipulate the image to suit its intended purpose to your document. 

To Crop an Image 
Crop in computer graphics means ―to cut off the sides of an image to make it the 
proper size or to remove unwanted parts.‖ Follow the steps below on how to crop an 
image. 

1. Select an image. The Format tab will appear. 

2. Select the Format tab. 

3. Click the Crop command. The black cropping handles appear. 

 

4. Click and drag a handle to crop an image. 

5. Click the Crop command to deselect the crop tool. 

 

Welcome to Lesson 24 of Unit 2. In Lesson 23, you have 
learned the definition of picture from a file, how to insert it and 
its importance in the document.  In this lesson, you will learn 
how to format the picture from a file which you have learned 
how to insert Lesson 23. 
 

Your Aims: 
 perform the steps on formatting picture from a 

file 

 determine the importance of formatting  
picture from a file 

Corner handles 

http://www.webopedia.com/TERM/G/graphics.html
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To Crop an Image to a Shape 
Cropping an image to a shape allows you to have the image takes the form of a 
chosen shape. Follow the steps below on how to crop an image to a shape. 
1. Select the image. The Format tab will appear. 

 

2. Select the Format tab. 

3. Click the Crop drop-down arrow (below the Crop command). A drop-down 
menu will appear. Select Crop to Shape. 

 
4. Select a shape from the drop-down menu. 

Corner handles will allow you to simultaneously crop the image horizontally and 
vertically. 

 

Drop-down arrow 

1 

2 
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To Add a Border to a Picture 
Adding a border to your image will make the image more defined and emphasized. 
Follow the steps below on how to add border to a picture. 

1. Select the picture. 

2. Select the Format tab. 

3. Click the Picture Border command. A drop-down menu will appear. 

 

You may want to crop the image to the desired size before 
cropping it to a shape. 

 

The image will take the shape that you have selected. 

4 

2 

3 
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4. From the drop-down menu, you can select a color, weight (thickness), and 

whether or not the line is dashed. 

 

 

 

Image Adjustments 
Images can be adjusted when it comes to their brightness and contrasts. Microsoft 
Word 2010 has made it easier to adjust these with just a choice and a click of the 
button. 

To Make Image Corrections 
Follow the steps below on how to do image corrections to inserted pictures. 
1. Select the image. The Format tab will appear. 
2. Click the Format tab. 

3. Click the Corrections command. A drop-down menu will appear. 

 

The image showing the colour, weight and type of lines used in.  

2 
3 
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4. To sharpen or soften the image, hover over the Sharpen and Soften presets. 

You will see a live preview of the preset in the document. 

5. When you have found a preset you like, click on it to select it. 

6. Click the Corrections command again. 

7. Hover over the Brightness and Contrast presets to see a live preview. 

8. When you have found one you like, click on it to select it. 

 

 

To Adjust the Colour in an Image 
Colour adjustments can be made with the Color command found in the Format tab. 
With this, you can easily adjust the colour saturation, colour tone and recolour the 
image you have selected. Follow the steps below on how to adjust the coulour in an 
imange 
 
1. Select the image. The Format tab will appear. 

2. Click the Format tab. 

3. Click the Color command. A drop-down menu will appear. 

 

4. From the drop-down menu, you can choose a preset from each of the three 
categories: 

 Colour Saturation: Controls how vivid the colours are in the image. 

 Colour Tone: Controls the "temperature" of the colour, from cool to 
warm. 

You can also select Picture Corrections Options from the drop-down menu to 
refine the settings. 

 

2 
3 

4 
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 Recolour: Controls the overall colour of the image. Use this option to 
make the image black and white, grayscale, or to colourize it with a 
different colour. 

 

 

Artistic Effects and Styles 
Aristic effects enable the picture to have all the different properties of graphic effects 
that will further enhance the picture to suit its purpose in your document. Microsoft 
Word 2010 presents a wide selection of choices for this formatting type. 

To Apply an Artistic Effect 
Follow the steps below on how to apply an artistic effect to your picture. 
 
1. Select the picture. The Format tab will appear. 

2. Click the Format tab. 

3. Click the Artistic Effects command. A drop-down menu will appear. 

 

4. Hover over the different presets to see a Live Preview of each one. 

5. When you have found a preset you like, click on it to select it. 

 
 
 
 

 
 
 

You can also select Picture Color Options from the drop-down menu to refine 
the settings. 

 

To adjust the settings for the effect, click Artistic Effects again and select 
Artistic Effect Options. 

 

Many Clip Art images do not allow you apply artistic effects. Generally 
speaking, the ones that look handdrawn or painted do not work, while 
photographs do. 

 

2 

3 
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To Apply a Picture Style 
Follow the steps below on how to apply a picture style to your image. 
 
1. Select the picture. The Picture Tools group will appear. 

2. Select the Format tab.  

3. Click the More drop-down arrow to display all the picture styles. 

 

4. Hover over a picture style to display a live preview of the style in the 
document. 

 

5. Select the desired style to apply changes to your image 

 

 

6. To refine the picture style, click the Picture Effects drop-down menu. 

7. Choose from the different Effects available. 

1 
2 

3 

4 

Style is immediately 
shown as you hover 
over a style.  

The image displaying the Picture style selected. 
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Compressing Pictures 
Image compression is minimizing the size in bytes of a graphics file without 
degrading the quality of the image to an unacceptable level. You will need to monitor 
the file size of your documents that include pictures, especially if you send them via 
email. File size measures the size of a computer file. Large, high-resolution pictures 
can quickly cause your document to become too large, which may make it difficult or 
impossible to attach to an e-mail.  

In addition, cropped areas of pictures are saved with the document by default, which 
can add to the file size. Ms Word can reduce the file size by compressing pictures, 
lowering their resolution, and deleting cropped areas. 

 
To Compress a Picture 
Follow the steps below on how to reduce the file size of your document. 

1. Select the picture. The Format tab will appear. 

2. Click the Compress Pictures command in the Adjust group. A dialogue box 
appears. 

 

6 

7 

2 
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3. Place a checkmark next to Delete cropped areas of pictures. You can also 

choose whether to apply the settings to this picture only or to all pictures in 
the document. 

4. Choose a Target output. If you are emailing your document, you may want to 
select Email, which produces the smallest file size. 

 
5. Click OK. 
 

 
 
 

1. Explain the importance of formatting a picture in a Word document. 
 

______________________________________________________________

______________________________________________________________ 

 

2. List the different ways on how you can format a picture. 

______________________________________________________________

______________________________________________________________

_____________________________________________________________ 

3. What tab are you going to select if you would like to format your picture? 

______________________________________________________________

______________________________________________________________ 

 

Activity 1:  Answer the following questions. 
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4. What must you do first before you can format a picture and for the needed tab 

to appear? 

______________________________________________________________

______________________________________________________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 

Summary 
You have come to the end of Lesson 24. In this lesson you have 
learned how to format the picture from a file that you have learned 
to insert in Lesson 23. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICAL EXERCISE 24 ON THE NEXT PAGE. 



GR10 D&T – COMPUTING U2          240  TOPIC 4 LESSON 24  
  
Practical Exercise  24 
 

Follow the given instructions below on how to format a picture in different 
ways. 
1. Open a blank document. 

2. Select Penguins picture from the Pictures Folder. Click Insert. 

3. Select the picture and the Format tab will appear. 

4. From the format tab, select down arrow in Crop. Chose Crop to shape. 

5. Crop the picture to the shape of Plaque. 

6. Select the picture again to displat the Format tab. Choose Corrections. 

7. From Corrections under Soften and Sharpen, click 25% and from the 
Brightness and Contrast choose Brightness 0 and Contrast 20 %. 

8. Repeat Step 7 but choose Color. 

9. Under Color choose Recolor to Olive Green, Accent Color 3 Dark. 

10. Repeat Step 8 but choose Artistic Effects. 

11. Under Artistic Effects choose Watercolor sponge. 

12. Repeat Step 10 but choose Picture Border. 

13. Under Picture Border, change the weight to 2 ¼ pt. 

14. Repeat Step 12 but choose Picture Effects. 

15. Under Picture Effects, choose Glow (Purple, 18 pt glow, accent color 4). 

16. Repeat Step 14 but choose Compress Pictures. 

17. In the Compress picture dialog box, place a checkmark next to Delete cropped 
areas of pictures.  

18. Next, choose a Target output and select Email.  

19. Save your work as Penguin Formatting Pictures. 

 

 
 
 
 
 

CHECK YOUR WORK.  ANSWERS ARE AT THE END OF TOPIC 4. 
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Answers To Activity 1 
1. Formatting pictures makes it easier for readers to understand your pictures 

ang give your document a more interesting and professional presentation. It 
enables you to manipulate the image to suit its intended purpose to your 
document. 

2. Crop, add borders, image corrections, adjust colour in an image, apply artistic 
effects, apply picture style and compress pictures. 

3. Format tab 

4. Select the picture. 
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Answers to Practical Exercises in Topic 4 
 
 
Practical Exercise 19 

Rubric to assess students’ work 
Shape 1 
 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Selected the Insert Tab on the ribbon.  
2) Located the Shapes icon on the ribbon and clicked on it.  
3) Chose and clicked the Regular Pentagon under the Basic 

Shapes.  
 

4) Dragged and positioned the shape in the center of the 
document. 

 

5) Changed the shape style to Colored Fill, White Outline- 
Accent 6 and shape outline weight to 6pt. 

 

Total  
 
Shape 2 
 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Selected the Insert Tab on the ribbon.  
2) Located the Shapes icon on the ribbon and clicked on it.  
3) Chose and clicked Isosceles Triangle under the Basic 

Shapes.  
 

4) Dragged and positioned the shape in the center of the 
document. 

 

5) Enlarged the shape.   

6) Rotated the shape so it will become an up side down  
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isosceles triangle.  

7) Changed the shape fill to texture – Water Droplets and 
shape outline to 4 ½ pt.  

 

Total  
 
Shape 3 
 

Categories 
for marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task component not 
done 

 

Task 
component 

partially 
completed 

 

Task component 
done confidently, and 

properly 

Tasks to perform  
1) Selected the Insert Tab on the ribbon.  
2) Located the Shapes icon on the ribbon and clicked on it.  
3) Chose and clicked Arrow under Lines.   

4) Dragged and positioned the shape into the document.  
5) Repeated steps 3-4 twice.  

6) Moved the three arrows in such a way that their arrow heads intersect in 
the middle. 

 

7) Changed the shape outline weight to 3pt, 6pt and 2 ½ pt respectively.  

Total  
 

Sample output results 

Shape 1 
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Shape 2 

 

Shape 3 

 

Practical Exericise 20 

Rubric to assess students’ work 

Categories 
for marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task component 
not done 

 

Task 
component 

partially 
completed 

 

Task component 
done confidently, 

and properly 

Tasks to perform  
  
  

Total  
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Practical Exericise 21 

Rubric to assess students’s work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Opened a blank document.  
2) Went to Insert Menu and clicked on Charts.   

3) Chose Bar Chart (Clustered Bar). Clicked OK.  

4) Enter the data below. Categories are Bart, Claudia, Henry 
and Poly while Mathematics, Science and English are the 
Series. 

 
 
 
 
 
 

 

5) Clicked on the inserted chart.   

6) Under the Chart Tools, clicked on Design and chose Chart 
Style 46. 

 

7) Repeated Step 6. Clicked on Layout.  

8) Under Layout, selected Chart Title (Above Chart) and wrote  



GR10 D&T – COMPUTING U2          246  ANSWERS TO TOPIC 4 
  

Term 1 Marks as the chart title. 

9) Repeated Step 6. Clicked on Format.  

10)  Under Format, selected Shape Style and chose Colored 
Outline – Aqua, Accent 5. 

 

11)  Repeated Step 6. Clicked on Design.  

12)  Under Design, selected Change Chart Type.  

13)  Selected Line (Stacked Line) and clicked OK.  

Total  
  

Sample output 

 

 

Practical Exericise 22 

Rubric to assess students’ work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1) Opened a blank document.  

79

80

81

82

83

84

85

86

87

88

89

65 70 75 80 85 90 95

Bart

Claudia

Henry

Poly

Term 1 Marks 

English

Mathematics

Science
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2) Clicked Insert menu and selected Clip Art.  

3) Inside the Search for: field, typed the keyword ―sports‖.  

4) Reviewed the search results and selected the clip art for 
―athletes, baseball‖. 

 

5) Clicked the clip art and appeared in the document.  

6) Rotated the clip art upside down and enlarged it by using 
the handles. 

 

Total  

Sample output 
 
 
 
 
 
 
 

 

Practical Exericise 23 

Rubric to assess students’ work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1. Type and save a document.  
2. Insert a picture of a ―Penguin‖ from the Picture Library.  
3. Resize the object.  
4. Apply Square Text Wrap to the object (image of the Penguin).  

Total  
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Your work should look like the example below. 
 

 
 
 
 
 
 
 
 
 
 

Practical Exercise 24 

Rubric to assess students’ work 

Categories for 
marking 

Not acceptable 
expectations 

( 1 mark) 

Below 
expectations 

( 3 marks) 

Meet 
expectations 

( 5 marks)  
 
 

Score 
Assessment 

Criteria 
 

Task 
component not 

done 
 

Task 
component 

partially 
completed 

 

Task 
component 

done 
confidently, and 

properly 
Tasks to perform  
1. Insert picture from Pictures Library  
2. Apply cropping tecniques.  
3. Use Crop to Shape of Plaque the inserted object  
4. Apply Correction to object using 25% Soften and Sharpen.  
5. Apply 0% Brightness and 20% Contast to picture.  
6. Apply Colour and Recolour to picture  
7. Apply Water colour sponge type of Artistic Effect  
8. Apply Picture border using 2 1/4 pt. weight  
9. Apply Glow (Purple, 18 pt glow, accent color 4) effect to 

picture. 
 

10. Apply Compress Picture to image.  
11. Delete the cropped areas of the picture.  
12. Send the file as an email.  

Total  
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Your work should look like the example below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

End of Topic 4 
 

Now Do Exercise 4 in Assignment Book 4. 
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Application Software program. Is a computer program designed to perform a group 

of coordinated functions, tasks, or activities for the benefit of the user. 

Backstage View. It is where to manage files and the data about it.  It is used to 

create, save, and inspect hidden personal information and setting options. 

Cell. Is identified by a column and row in a table. 

Clip Art. Simple pictures and symbols made available for computer users to add to 

their documents 

Clip Board. A temporary storage are for data that the user wants to copy from one 

place to another. 

Columns. Is a vertical group of values within a table. 

Copy. Is the act of duplicating text, data, files, or disks, producing two or more of the 

same file or segment. 

Crop. Command use to reduce the size of an image or to remove non-important 

aspects of an image. 

Curriculum Vitae. A brief account of person’s education, qualifications, and previous 

occupations, typically sent with a job application. 

Cursor. Is a visual representation that allows the user to specify where they want 

text to be placed. 

Cut. The process of removing an item and placing it in a temporary location called 

the clipboard. 

Data. The information that have been gathered and translated for some purpose, 

usually analysis.  It can be any character, including text and numbers, pictures, 

sound, or video 

Delete. Refers to the act of eliminating a file, text, or other object from the computer 

hard drive or other media. 

Desktop. Refers to the desktop environment, which is a Graphical User Interface 

metaphor that allows for interaction between the user and the operating system. 

Document. Also known as document file, is a description of an electronic copy or 

hard copy of reference material for a product. 

File.  Is an object on a computer that stores data, information, settings or commands 

that are used with a computer program. 
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Find.  Is a term used to describe a process of locating a specified text, file, document 

or other object on a computer or the internet. 

Flash Drive.  Is a portable storage device. 

Font Size.  Is the overall size (generally height) of a font shown on the screen or 

printed on a page. 

Graphic.  Any image media, usually movies and pictures, which are created through 

the use of hardware and software.  They are often referred to as computer-generated 

imagery. 

Hard Copy. Is anything that that has been printed on paper.  It allows data to be read 

without the need of a computer and are often required when someone needs to sign 

a document. 

Icon. Is a small graphical representation of a program or file that, when clicked on, 

will be run or opened. 

Indention. The action of indenting or the state of being indented. 

Landscape.  The orientation of a page that prints the image horizontally across the 

page instead vertically. 

Memo.  Message or information in writing sent by one person or department to 

another in the same business organization. 

Menus.  Also referred as file menu.  It is a list of commands or choices offered to the 

user. 

Microsoft Word.  Is a word processor that allows you to create a professional 

looking document, report, letter, and resume. 

MS Office.  Is a collection or package of software programs commonly used in an 

office environment. 

Objects.  Refers to an item within a graphic, such as graphic circle or a square. 

Orientation.  Is a term used to describe the positioning or overall layout of an item in 

relation to other items. 

Page Layout.  Refers to the placement of elements within the page and their spatial 

relation to one another. 

Paste.  Is an operating system and programs action that allows you to copy an object 

or text from one location and place it to another location. 
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Portrait.  Is the orientation of the page that prints the image vertically across the 

page instead of horizontally. 

Pre-Existing Templates.   

Preview.  Refers to the feature that allows you to glimpse or view something in part 

or whole without it being opened. 

Print Preview.  Shows how a page or document looks when printed. 

Quick Access Toolbar.  Is a toolbar menu that appears in MS Excel, MS Word, and 

other office 2007.  It gives you quick access to commonly used features such as the 

Save features. 

Redo.  Is a function performed on a computer that does any undo function again. 

Replace.  Alternatively referred to as Search and Replace, Find and Replace or 

Replace is the act of finding text and replacing the found text with an alternative. 

Report.  Is a concise summary distilled from a larger set of data intended for a 

specific audience. 

Resume. A brief written account of personal, educational, and professional 

qualifications and experience, as that prepared by a applicant for a job. 

Ribbon.  Is a feature in MS Office that replaces the traditional File menu.  

Rows.  A series of data banks laid in a horizontal fashion in a table. 

Ruler.  A measurement tool found with some software programs that allow the 

program’s user to align graphics, text, tables, or other elements on a page. 

Save.  The process of writing data to a storage medium such as hard drive. 

Soft Copy.  Is a copy of text stored on the computer and only accessible through the 

computer. 

Software.  Software is a collection of instructions that enable the user to interact with 

a computer, its hardware, or perform tasks. 

Spell Checker.  A program or program feature designed to locate misspelled words 

and notify the user of the misspellings. 

Storage Device.  Alternatively referred to as digital storage, storage media, or 

storage medium.  It is any hardware capable of holding information either temporarily 

or permanently. 
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Strikethrough.  Is a font effect that causes text to appear as though it is crossed out. 

Subscript. Is a character that are half the height of a standard character and printed 

lower than the rest of the text. 

Superscript.   Is a character that is half the height of a standard character and 

printed higher than the rest of the text. 

Table.  Is an arrangement of information in rows and columns that make comparing 

and contrasting information easier. 

Tabs.  It is an indention at the beginning of a line of text to signify a new paragraph in 

a document or to help create equal spacing between multiple lines. 

Tabular Stop.   

Task Bar.  A bar located at the bottom of screen that allows the user to locate and 

launch programs through the Start button or view any program that is currently open.  

It also allows them to check the date and time. 

Template.  Is a file that has been created with an overall layout and format to be 

used for a group of documents or generic document. 

Text.  Is a collection of words or letters that are understandable by the reader. 

Thesaurus.  Is a software tool included with some word processors that provides 

synonyms for selected words on command. 

Tool Bar.  Sometimes referred to as a bar, the toolbar is a row of boxes, often at the 

top of an application window that control various functions of the software. 

Undo.  Is a function performed to reverse the action of an earlier action. 

Virus.  Is a program, script, or macro designed to cause damage, steal personal 

information, modify data, send e-mail, display messages, or some combination of 

these actions. 

Word Processing.  Describes the process of creating or editing a document using a 

word processor such as Microsoft Word. 

Word Processor.  Is a software program capable of creating, storing, and printing 

documents. 
 
 
 
 
 


